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Avant-propos 

Ce manuel est le support principal des travaux pratiques de télédétection spatiale du 
cours de télédétection spatiale dispensé sur le Campus d’Arlon Environnement, 

Université de Liège, Belgique. 
 

Ce manuel est téléchargeable gratuitement à l’adresse web : 
http://orbi.ulg.ac.be/handle/2268/143553  

Les données associées à ces travaux pratiques ne sont disponibles que pour les 
étudiants inscrits à ce cours. Le logiciel principalement utilisé dans ce TP est un 

logiciel payant (ENVI, de la firme EXELIS). Les autres logiciels utilisés sont gratuits et 
disponibles sur le web.  

 
Pensez à l’environnement avant d’imprimer ces notes!!** 

 
Ce manuel a été rédigé par Antoine DENIS 

Université de Liège (ULg) 
Arlon Campus Environnement 

Département des Sciences et Gestion de l’environnement 
Unité Eau Environnement Développement (EED) 

 Avenue de Longwy, 185 
6700 Arlon, Belgique 

Antoine.Denis@ulg.ac.be  
 

Merci de signaler toute erreur rencontrée dans ce manuel par email à l’adresse ci-
dessus. 

Les mises à jour de ce manuel seront disponibles via l’adresse web ci-dessus. 
 

Version du 21 janvier 2016. Version provisoire. 
 

Sont également disponibles, du même auteur, les manuels de Travaux Pratiques : 

 SIG - QGIS (le logiciel SIG gratuit de référence  
http://orbi.ulg.ac.be/handle/2268/190559  

 SIG - ArcGIS https://orbi.ulg.ac.be/handle/2268/135775  

 
Images de couverture : images extraites du livre « EARTH as ART », NASA disponible à l’adresse 

http://www.nasa.gov/connect/ebooks/earth_art_detail.html et vue d’artiste du satellite « Sentinel 2 ». 
 

* Comment citer ce manuel ? : « Travaux Pratiques de télédétection spatiale, Antoine DENIS, 2013, Arlon 
Campus Environnement, Université de Liège, Belgique ». 

 
** N’imprimez pas ces notes ! Si vous devez les imprimer, utilisez le verso de feuilles déjà utilisées, imprimez 

recto-verso et/ou imprimez en 2 pages par feuilles. 

http://orbi.ulg.ac.be/handle/2268/143553
http://www.eed.ulg.ac.be/antoine-denis/
http://www.ulg.ac.be/
http://www.facsc.ulg.ac.be/cms/c_636656/fr/accueil-arlon-campus-environnement
http://www.facsc.ulg.ac.be/cms/c_636656/fr/accueil-arlon-campus-environnement
http://www.eed.ulg.ac.be/
mailto:Antoine.Denis@ulg.ac.be
http://orbi.ulg.ac.be/handle/2268/190559
https://orbi.ulg.ac.be/handle/2268/135775
http://www.nasa.gov/connect/ebooks/earth_art_detail.html
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1 Objectifs du TP 

Dans le cadre de ce TP, vous serez initié à la pratique de la télédétection spatiale. En 

particulier, à la fin de ce TP, vous serez capable de réaliser les opérations suivantes : 

 Visualiser en 2D et 3D des images issues de la télédétection spatiale 

 Comprendre et expliquer différents types d’images : 

o Résolutions 

o Format 

o Signification dans le monde réel 

o … 

 Manipuler différents types d’images à l’aide de différents logiciels spécialisés:  

o Images multispectrales et hyperspectrales 

o Images basse et haute résolutions spatiales 

o Images mono et multi-temporelles 

 Produire de nouvelles informations à partir de traitements appliqués sur des images:  

o Calcul d’indices spectraux 

o Analyse de changement temporel 

o Classification d’image en vue de la réalisation d’une carte d’occupation du sol 

o Correction géométrique d’images 

o … 

 Rechercher des images satellites sur le web 
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2 Notions de télédétection – Rappel théorique 

2.1 Définition 

La télédétection (détection à distance, Remote Sensing (RS) en anglais) désigne, dans son 

acception la plus large, la mesure ou l'acquisition d'informations sur un objet ou un 

phénomène, par l'intermédiaire d'un instrument de mesure n'ayant pas de contact avec 

l'objet étudié (Figure 1).  

C'est l'utilisation à distance (par exemple, d'un avion, d'un engin spatial, d'un satellite ou 

encore d'un bateau) de n'importe quel type d'instrument permettant l'acquisition 

d'informations sur l'environnement. On fait souvent appel à des instruments tels 

qu’appareils photographiques, lasers, radars, sonars, sismographes ou gravimètres.  

 

Figure 1 : Principe de la télédétection spatiale (Source : http://www.alertes-meteo.com/) 

 

http://fr.wikipedia.org/wiki/Satellite_artificiel
http://fr.wikipedia.org/wiki/Bateau
http://fr.wikipedia.org/wiki/Environnement
http://fr.wikipedia.org/wiki/Laser
http://fr.wikipedia.org/wiki/Radar
http://fr.wikipedia.org/wiki/Sonar
http://fr.wikipedia.org/wiki/Sismographe
http://fr.wikipedia.org/wiki/Gravim%C3%A8tre
http://www.alertes-meteo.com/
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L’on distingue en général les moyens de télédétection « actif » et « passif » (Sources : André 

Ozer) 

 Télédétection passive: enregistrement du rayonnement naturel, fourni par la lumière 

ou la chaleur, qu’il soit émis, réfléchi ou réfracté (ex : photographies aériennes du 

paysage éclairé par la lumière du soleil ainsi que certaines images satellitaires comme 

(SPOT, LANDSAT, IKONOS,…) 

 Télédétection active : enregistrement du rayonnement que réfléchit l’objet ou le 

paysage « illuminé » par l’opérateur (ex : images radar) 

La télédétection spatiale, dans le domaine de l'astronautique, est l'ensemble des 

connaissances et des techniques utilisées pour déterminer les caractéristiques de la surface 

et de l'atmosphère de la Terre ou d'une autre planète, par des mesures effectuées à partir 

d'un engin spatial évoluant à distance convenable de cette dernière. Le terme correspondant 

en anglais est « remote sensing from space ». 

2.2 Principe 

Ce type de méthode d'acquisition utilise normalement la mesure des rayonnements 

électromagnétiques émis ou réfléchis des objets étudiés dans un certain domaine de 

fréquence (infrarouge, visible, micro-ondes – Voir Annexe 5). Ceci est rendu possible par le 

fait que les objets étudiés (plantes, maisons, surfaces d'eau ou masses d'air) émettent ou 

réfléchissent du rayonnement à différentes longueurs d'onde et intensités selon leur état. 

Certains instruments de télédétection utilisent des ondes sonores de façon similaire, et 

d'autres mesurent des variations dans des champs magnétiques ou gravitaires. 

2.2.1 Réflectance solaire 

La réflectance solaire se définit comme le rapport entre l'énergie solaire réfléchie et 

l'énergie solaire incidente sur une surface (Energie Solaire Réfléchie / Energie Solaire 

Incidente (Figure 2). Par exemple, une réflectance de 100% signifie que la surface en question 

réfléchit toute l'énergie solaire dans l'atmosphère et n'en absorbe aucune fraction. 

 

http://fr.wikipedia.org/wiki/Astronautique
http://fr.wikipedia.org/wiki/Terre
http://fr.wikipedia.org/wiki/Plan%C3%A8te
http://fr.wikipedia.org/wiki/Engin_spatial
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Figure 2 : Principe de la réflectance solaire 

2.3 Applications 

Les exemples d’applications de la télédétection spatialesont très nombreux : 

 Les cartes topographiques sont souvent produites à l'aide de paires stéréographiques 

de photos aériennes permettant de recréer une image en trois dimensions.  

 Les modèles numériques de terrain peuvent être produits par interférométrie, 

méthode consistant à enregistrer une série de mesures de la cible à partir d'un avion, 

d'un satellite ou d'une navette spatiale. La combinaison des données issues de ces 

mesures offre une carte détaillée contenant de l'information sur la couverture du sol, 

le relief ou encore le mouvement à une échelle centimétrique. Les données couvrent 

généralement des bandes de plusieurs kilomètres de largeur.  

 Les précipitations, les aéronefs et les navires peuvent être détectés par radars.  

 Les fonds marins sont cartographiés grâce à l'usage des sonars. 

 

   

Figure 3 : Quelques exemples d’application de la télédétection spatiale : carte d’occupation du sol, 
suivi des conditions atmosphériques, réalisation de modèles numériques de terrain (MNT) 

http://fr.wikipedia.org/wiki/Carte
http://fr.wikipedia.org/wiki/St%C3%A9r%C3%A9ographie
http://fr.wikipedia.org/wiki/Interf%C3%A9rom%C3%A9trie
http://fr.wikipedia.org/wiki/Avion
http://fr.wikipedia.org/wiki/Satellite_artificiel
http://fr.wikipedia.org/wiki/Navette_spatiale
http://fr.wikipedia.org/wiki/Pr%C3%A9cipitation
http://fr.wikipedia.org/wiki/A%C3%A9ronef
http://fr.wikipedia.org/wiki/Navire
http://fr.wikipedia.org/wiki/Radar
http://fr.wikipedia.org/wiki/Sonar
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3 Introduction au TP : « Google Earth » 

« Google Earth » est probablement la plus belle application de la télédétection spatiale 

réalisée à ce jour. Connectez-vous à internet. Si Google Earth n’est pas encore installé sur 

votre ordinateur, téléchargez-le à l’adresse http://www.google.fr/earth/ et installez-le. Une 

fois installé, démarrez Google Earth (une connexion internet est nécessaire).  

 

 

 

 

 

 

 Localisez le Campus d’Arlon et en particulier le bâtiment de la salle informatique 

 Cochez l’option « Relief » dans le panneau « Infos pratiques » et déplacez-vous dans 

les Alpes, l’Himalaya ou une chaîne de montagne de votre choix. Utilisez l’outil 

« Lumière du soleil en fonction de l’heure du jour » et constatez l’effet de la position 

du soleil sur le réflectance des images. Inclinez ensuite votre fenêtre de visualisation 

dans le plan horizontal et déplacez-vous dans les montagnes. 

 Tapez ensuite « Manhattan, New-York » dans l’onglet « Allez à ». Vous devriez 

arriver à « Central Park ». Déplacez-vous ensuite vers la pointe sud de Manhattan et 

cochez l’option « Bâtiments 3D ». Inclinez à nouveau la fenêtre de visualisation dans 

le plan horizontal et visitez Manhattan. Déplacez-vous ensuite vers la « Statue of 

Liberty ». 

 Déplacez-vous ensuite vers Paris et explorez « l’Avenue des Champs Elysées » et 

« l’Arc de triomphe » à l’aide de l’outil « Street view ». 

 Découvrez ensuite une vision nocturne de la terre en cochant la rubrique 

« Gallerie/NASA/Lumières de villes de la Terre » 

 La couverture nuageuse (mise à jour toutes les 60 à 90minutes) ainsi que les masses 

nuageuses pluvieuses détectées par radar (mise à jour toute les 5-6 minutes) peuvent 

être affichées via les menus « Météo/Nuages » et « Météo/Radar ». 

Google Earth permet également d’explorer les fonds marins, l’espace, la Lune et Mars. 

Rem : Attention ! Il est possible de récupérer les images de Google Earth : 

 Via une « capture d’écran » (« print screen » en anglais) ou  

 Via le menu de Google Earth « Fichier > Enregistrer > Enregistrer l’image… ».   

Notez qu’il s’agira cependant d’une image « dégradée » correspondant au zoom et à 

l’étendue au moment de la capture, le plus souvent au format « jpg », et non de l’image 

satellite originale utilisée pour réaliser cette représentation 

Google Earth 

http://www.google.fr/earth/
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4 Pratique de la télédétection spatiale  

Avant toute chose, copiez  les données géographiques dont vous allez avoir besoin pour ce TP 

sur votre ordinateur. Ces données se trouvent sur le réseau et sont accessibles  depuis le 

bureau des PC de la salle informatique du campus d’Arlon dans le dossier 

« T:\Cours\GEOMATIQUE\TELEDETECTION\ » ou via l’adresse 

« \\139.165.119.140\transit\Cours\GEOMATIQUE\TELEDETECTION »  à taper dans votre 

explorateur Windows. Copiez le dossier « TELEDETECTION », depuis le réseau vers votre 

répertoire de travail à la racine de votre disque  D (ou H, H étant votre espace personnel à 

Liège sur les PC de la salle informatique) : « D:\ TELEDETECTION\». 

Au cours de ce TP, vous enregistrerez tous vos résultats dans le dossier  « D:\TELEDETECTION\ 

TP_TELEDETECTION\DATA_TP_ENVI_ULg\RESULTAT\». 

4.1 Présentation du logiciel de traitement d’images 
numériques ENVI 

ENVI (Environment for Visualizing Images) est un logiciel professionnel de la société 

« EXELIS » (http://www.exelisvis.com/ProductsServices/ENVI/ENVI.aspx) permettant la 

visualisation, le traitement, l’analyse, et la présentation de nombreux types d’images 

numériques, dont les images satellites.  

En particulier, Envi permet de travailler sur différents types de données (multispectrale, 

hyperspectrale, radar), d’intégrer des données de type matriciel (image) et vectoriel et est 

compatible avec des données de type SIG. Il permet entre autres de contraster les images, 

de les corriger géométriquement, de les classifier, de réaliser des analyses à l’aide de 

données d’élévations, etc. 

ENVI utilise le langage de programmation IDL (Interactive Data Language). 

4.1.1 Les 2 interfaces d’ENVI 

ENVI est composé de 2 interfaces-viewer indépendants : « ENVI » et « ENVI Zoom ». 

 ENVI est l’interface principale d’ENVI, vous donnant accès à toutes ses 

fonctionnalités. 

 ENVI Zoom est une version simplifié d’ENVI spécialement conçue pour afficher et 

manipuler plus facilement  et plus efficacement les images satellites (outils de zoom, 

file://///139.165.119.140/transit/Cours/GEOMATIQUE/TELEDETECTION
http://www.exelisvis.com/ProductsServices/ENVI/ENVI.aspx
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contraste, transparence, brillance, …, projection et rééchantillonnage des données au 

vol,…) 

4.1.2 Ouvrir ENVI 

 Ouvrez ENVI. : Démarrer > Tous les programmes > ENVI > ENVI 

 Ouvrez ENVI Zoom : Démarrer > Tous les programmes > ENVI > ENVI Zoom 

4.1.3 Trouver de l’aide dans ENVI 

L’aide d’ENVI est accessible via la barre de menu principale en cliquant sur  

 « Help > Start ENVI help » pour ENVI 

 « Help > Contents… » pour ENVI Zoom  

L’aide est accessible via, notamment, une table des matières, un index et une fenêtre de 

recherche. 

4.2 Exploration d’images satellites dans ENVI Zoom 

Dans cette section, vous allez découvrir les possibilités qu’offre ENVI Zoom pour visualiser des 

données géographiques (image et vecteur) et comprendre de quoi est composée une image 

satellite. 

4.2.1 Ouverture d’un fichier dans ENVIZoom 

 Soit, cliquez sur « File > Open > » puis naviguez jusqu’au fichier d’intérêt 

 Soit, cliquez sur l’icône « Open » (un dossier jaune entre-ouverte) puis naviguez 

jusqu’au fichier d’intérêt 

Ouvrez les fichiers  

 “C:\Program Files\RSI\IDL63\products\envizoom45\data\qb_boulder_msi 

 “C:\Program Files\RSI\IDL63\products\envizoom45\data\qb_boulder_pan 

Les images apparaissent dans le Viewer d’ENVIZoom.  
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4.2.2 Découverte de l’interface d’ENVIZoom et exploration d’images 

A l’aide de cette section découvrez les possibilités de visualisation qu’offre ENVIZoom avec 

ces 2 fichiers images. Répondez aux questions posées à la suite de cette section. 

L’interface d’ENVIZoom s’organise de la manière suivante : 

1. Le viewer principal : visualisation des données géographiques qui sont activées dans 
l’onglet « Layer Manager » du panneau latéral. 

2. Les barres de menus et d’outils : accès aux fonctionnalités d’ENVIZoom 

 Barre de menu : 

 File : permet notamment d’ouvrir un fichier, d’accéder au « Data Manager », 
d’accéder à des données sur internet, de sauver un fichier, de démarrer ENVI et de 
modifier vos préférences. 

 Edit : commande la disposition et affichage des couche, via l’onglet “Layer 
Manager” du panneau latéral (undo/redo, remove, order) 

 Display: permet d’activer les options de visualisation “Portal, Blend, Flicker, 
Swipe”. Un « Portal » est une petite fenêtre qui vient s’ajouter dans la fenêtre du 
viewer principal, et qui permet de visualiser simultanément plusieurs couches 
superposées. Le « Portal » se présente comme un bloc de données indépendant 
dans le « Layer Manager » du panneau latéral.   

 Processing : diverses opérations à réaliser sur image 

 Help : l’aide 

 Barres d’outils : 

 Data Manager : liste et donne des informations sur les fichiers précédemment 
ouverts, et permet de les charger dans le « Layer Manager » 

 Do / undo, select, « crosshairs », sauver la vue 

 Outils de déplacement (main, vol) et de zoom (interactif ou automatique) 

 Outils de création et édition vectorielle (désactivés en absence de couche 
vectorielle) 

 Outils de rotation de l’image (interactif ou automatique) 

 Options de visualisation simultanée de différentes couches : “Portal, Blend, Flicker, 
Swipe”. Ces boutons commandent le « Portal » du « Layer Manager » du  panneau 
latéral. (Un « swipe » doublé d’une rotation continue est du plus bel effet !) 

 « Go To » pour zoomer sur des coordonnées (pixel, géographiques ou carte) 

 Brillance, Contraste, Amélioration de contraste (méthode prédéfinie ou 
interactive), « sharpen », transparence 

3. Un panneau latéral :  

 « Overview » : positionne l’étendue de la vue du viewer principal par rapport à 
l’étendue maximale définie par le groupe d’images actives dans le « Layer Manager » 

 « Layer Manager » : se compose de 2 dossiers ou « bloc de données » indépendant : 
a. Le dossier « Layers » permet d’activer (« show »), d’organiser (« order »), 

supprimer, zoomer sur les couches. (Similaire à la table des matières 
d’ArcMap) 

b. Le dossier « Portals »: voir point 2 \ Display, ci-dessus 
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 « Cursor Value » : donne toute une série d’information sur le pixel « sélectionné » 
pour les différentes couches apparaissant dans le viewer principal : nom de la 
couche, système de coordonnées de la couche, coordonnées du pixel (fichier, carte, 
géographiques), valeur du pixel. 

 
Quelles différences remarquez-vous entre les deux fichiers ? Comment sont-ils structurés ? 

Complétez le tableau ci-dessous. Attention, indiquez clairement les unités. Vous avez le 

choix entre : byte, mètre, nanomètre ou sans unité. 

Caractéristiques \ Images Image « qb_boulder_pan » Image « qb_boulder_msi » 

Dimension matricielle du 
fichier (pixel * pixel * 
nombre de bandes) 

  

Résolution spatiale (taille du 
pixel) 

  

Résolution spectrale   

Taille du fichier   
Figure 4: Caractéristiques des images Quick Bird « Boulder » 

 

 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 
Figure 5: Interface d'ENVIZoom 

CURSOR VALUE 

LAYER MANAGER 

OVERVIEW 

3. PANNEAU LATERAL 

2. BARRES (menu et outils) 

1. VIEWER 

PORTAL 
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4.2.3 Intégration d’information de type vectoriel dans ENVIZoom 

Ouvrez une nouvelle interface d’ENVIZoom et ouvrez les 2 fichiers suivant : 

 Fichier vectoriel : COMMUNES_WALLONNES.evf 

 Fichier matriciel: SPOT10mNamur.tif 

L’ajout d’un fichier vectoriel, active les outils d’édition / création vectorielle. Testez les 

divers outils d’édition / création sur votre fichier « Communes wallonnes ». Créez par 

exemple une commune belge supplémentaire en France. Ne sauvez pas vos modifications. 

Accédez aux informations attributaires du fichier vectoriel. Elles s’affichent dans la fenêtre 

« Cursor Value » du panneau latéral lorsque vous sélectionnez une entité vectorielle à l’aide 

de la flèche de sélection. 
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4.3 Exploration d’images satellites dans ENVI 

Dans cette section, vous allez découvrir les principaux outils qu’ENVI propose pour explorer 

une image satellite :  visualisation et analyse. 

 Ouvrez ENVI : Démarrer > Tous les programmes > ENVI > ENVI 

L’interface d’ENVI s’ouvre. Il s’agit d’une simple barre de menu donnant accès à toutes les 

fonctionnalités d’ENVI (Figure 6). 

 

Figure 6: Interface / barre de menu principale d'ENVI (ENVI 5 Classic) 

4.3.1 Ouverture d’une image dans ENVI 

Dans cette section, vous allez travailler sur une image de type « Landsat Thematic Mapper » 

(Landsat TM). Quelques informations décrivant l’image LANDSAT TM (résolution spectrale et 

spatiale) sont présentées dans la table ci-dessous. 

Nom de la bande Résolution 
spatiale 

Longueur d’onde  

TM Band 1 

30 m 

0.42 – 0.52 µm ~ Bleu ~ Blue 

TM Band 2 0.52 – 0.60 µm ~ Vert ~ Green 

TM Band 3 0.63 – 0.69 µm ~ Rouge ~ Red 

TM Band 4 0.76 – 0.90 µm ~ Proche InfraRouge - PIR  ~ Near InfraRed – NIR 

TM Band 5 1.55 – 1.75 µm ~ Moyen InfraRouge – MIR ~ Middel InfraRed - MIR 

TM Band 6 (non-
disponible) 

100 m 
10.5 – 12.5 µm ~ InfraRouge Thermique – TIR ~ Thermic InfraRed - TIR 

TM Band 7 30 m 2.08 – 2.35 µm ~ Moyen InfraRouge – MIR ~ Middel InfraRed - MIR 

Figure 7 : résolution spectrale et spatiale de l'image Landsat Thematic Mapper 

 

Pour ouvrir cette image : 

 Cliquez sur « File > Open Image File » et naviguez vers le fichier image 

« Can_tmr.img » qui se situe dans le répertoire  “C:\Program 

Files\RSI\IDL63\products\enviz45\data\ can_tmr.img.  

 Cliquez « Ouvrir » 

La fenêtre « Available Band List » (liste de bandes disponibles) (Figure 8) s’ouvre avec le 

fichier « Can_tmr.img ». Cette interface vous permet de sélectionner la / les bande(s) à 

afficher dans une fenêtre de visualisation de votre choix, en « gray scale » (nuances de gris) 

ou en « RGB Color » (couleurs RedGreenBlue). 



 17 

 Cochez l’option « Gray Scale » 

 Sélectionnez  la bande que vous voulez faire apparaitre dans le canal noir et blanc du 

viewer en cliquant sur le nom de la bande. La bande sélectionnée apparait dans 

l’encadré « Selected Band » 

 Cliquez sur « Load Band » pour charger la bande sélectionnée dans une nouvelle 

fenêtre de visualisation. 

La bande de l’image LandsatTM apparait dans une triple fenêtre de visualisation. Ces trois 

fenêtres sont synchronisées spatialement. Elles se composent de : 

1. Image viewer : zoom intermédiaire correspondant à l’étendue du carré rouge du 

« Scroll viewer », accès aux fonctionnalités du viewer à travers une barre de menu 

2. Scroll viewer : vue d’ensemble de la bande 

3. Zoom viewer : zoom avancé sur l’étendue du carré rouge de « l’Image Viewer », 

modifiable via les options + et – dans le coin inférieur gauche de la fenêtre. 

 

 
Figure 8 : Ouverture d’une image dans ENVI : 3 fenêtres de visualisation synchronisées et fenêtre 

« Available Bands List » 

 
Ouvrez à présent une composition colorée de l’image Landsat TM dans un nouveau viewer. 

Dans la fenêtre « Available Band List », 

 Cochez l’option « RGB Color » 
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 Sélectionnez chacune des 3 bandes que vous voulez faire apparaitre dans les 3 

canaux RGB de votre viewer en cliquant sur le nom de la bande. Choisissez R = TM 

Band 4, G = TM Band 7, B = TM Band 3. 

 Cliquez sur l’onglet « Display # 1 » et choisissez « New display » pour créer une 

nouvelle fenêtre de visualisation. 

 Cliquez sur « Load RGB » pour charger les 3 bandes sélectionnées dans cette nouvelle 

fenêtre de visualisation. 

Les 3 bandes sélectionnées de l’image LandsatTM apparaissent dans la nouvelle fenêtre de 

visualisation (Figure 8).  

Prenez le temps d’observer vos images. Que voyez-vous en termes d’occupation du sol ? En 

termes de relief ? 

Il s’agit ici d’une « composition fausses couleurs » car les longueurs d’ondes que vous avez 

attribuées aux 3 canaux RGB, ne correspondent pas à ces 3 couleurs. Les couleurs 

apparaissant à l’écran ne correspondent pas aux couleurs réelles de la scène observée.  

Les compositions fausses couleurs présentent l’avantage de permettre la visualisation de 

données n’appartenant pas au spectre du visible, par exemple, l’InfraRouge, mais aussi des 

données de type radar, hyperspectral, élévation, etc. Autrement dit, elle « transforment » la 

donnée non visible (mais enregistrée par un capteur) en une donnée visible. 

Ouvrez maintenant une « composition vrais couleurs » de cette même image dans un 3ème 

viewer. Quelle bande TM choisissez-vous pour les 3 canaux RGB ?  

Réponse : R = TM3 , G = TM2, B = TM1.  

Cette composition colorée se rapproche plus des couleurs réelles de la scène observée. 

Canaux de visualisation de l’ordinateur 
Longueur d’onde des bandes spectrales d’une composition 

colorée 

Initiale Couleur VRAIE COULEUR FAUSSE COULEUR 

R Red Red [630nm – 700nm] Toutes compositions 
différentes de la composition 

vraie couleur 
G Green Green [490nm – 560nm] 

B Blue Blue [450nm – 490nm] 

4.3.2 Modification du répertoire de travail par défaut 

Lors de l’ouverture d’une image dans ENVI, ENVI présente le répertoire par défaut, par 

exemple « C:\Program Files\RSI\IDL63\products\envi45\data » ou, plus récemment, 

« C:\Program Files\Exelis\ENVI50\classic\data ». Pour modifier le répertoire par défaut,  

 Cliquez sur « File > Preferences > Default Directories > Data Directory > Choose » et 

naviguez vers le répertoire que vous désirez comme répertoire par défaut 
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 Choisissez le répertoire « D:\DATA_TP_ENVI_ULg\ » comme répertoire par défaut 

pour les données. 

4.3.3 Accès aux informations d’une image 

Plusieurs outils, présentés ci-dessous, sont disponibles pour accéder aux informations 
caractérisant l’image. 

4.3.3.1 Cursor Location / Value… 

 Cliquez-droit sur une de vos images dans une des fenêtres de visualisation 

 Choisissez « Cursor Location / Value » 

La fenêtre « Cursor Location / Value » qui apparait vous renseigne sur la position et la valeur 

du pixel sélectionné. 

4.3.3.2 Pixel Locator… 

 Cliquez-droit sur une de vos images dans une des fenêtres de visualisation 

 Choisissez « Pixel Locator » 

La fenêtre « Pixel Locator » qui apparait, vous renseigne sur la position du pixel se trouvant 

au centre du carré rouge. Cette position est exprimée en Sample = Colonne et Line = Ligne. 

4.3.3.3 Le « Header file » (fichier d’accompagnement). 

Le « Header File » contient toute une série d’information sur le fichier-image. Pour y 

accéder, 

 Cliquez sur « File > Edit ENVI Header » dans la barre de menu principale d’ENVI. 

 Sélectionnez le fichier d’intérêt dans la fenêtre « Edit Header Input File » 

Les informations sur ce fichier apparaissent dans la colonne « File Information ». 

 Remplissez le tableau ci-dessous à l’aide des informations que vous y trouvez. 

 Cliquez « Cancel » car vous ne voulez pas modifier le « Header File ». 

Caractéristique du fichier-image Landsat TM « Can_tmr.img » 

Dimension de l’image : nombre de pixel colonne * 
nombre de pixel ligne * nombre de bandes 

 

Taille du fichier (Byte)  

Intervalle de longueur d’onde  

Résolution spatiale 30 mètres 

Localisation de l’image – nom du lieu  
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4.3.3.4 Quick Stats… 

L’outil « Quick Stats… » calcule des statistiques sur vos images, dont la fréquence de 

distribution des valeurs de pixel dans chaque bande, les valeurs minimum, maximum, 

déviation standard, etc. 

 Cliquez-droit sur une de vos images dans une des fenêtres de visualisation 

 Choisissez « Quick Stats… » 

4.3.3.5 Outil de mesures (distance, superficie) 

L’outil « Measurement Tool » permet de mesurer des distances et des superficies sur une 

image : 

 Cliquez sur « Tool > Measurement Tool » dans la fenêtre de visualisation où se trouve 

l’image pour laquelle vous voulez réaliser une mesure. 

 Dans la fenêtre « Display Measurement Tool » qui apparait, choisissez le viewer 

d’intérêt, cochez la fenêtre d’intérêt, choisissez le type de mesure (lignes (distance), 

polygones (superficie)) et les unités (m, m², etc)  

 Réalisez la mesure dans la fenêtre d’intérêt 

La longueur du / des trait(s) ou la superficie du / des polygones dessinés s’indique(nt) dans la 

fenêtre « Display Measurement Tool ». 



 21 

4.4 Analyse temporelle 

L’analyse temporelle sera illustrée à l’aide de 2 logiciels : « ENVI » dans un premier temps, 

« Windisp » ensuite.  

4.4.1 Analyse  temporelle visuelle (avec ENVI) 

Ouvrez les deux images SPOT VEGETATION NDVI de l’Afrique « decade1_JANVIER_2006 »  et 

« decade1_SEPTEMBRE_2006 » dans 2 viewer différents (Figure 9). Elles datent de la 1ère 

décade de janvier 2006 et de la 1ère décade de septembre 2006 respectivement.  

Prenez quelques secondes pour les comparer. 

 

Figure 9 : Analyse temporelle de détection du changement dans ENVI à partir de 2 images NDVI sur 
l’Afrique : à gauche : image de janvier 2006 en noir et blanc ; au centre : image de septembre 2006 
avec la symbologie « GRN-RED-BLU-WHT » ; à droite : image résultante de l’analyse de 
changement (5 classes, méthode de « simple différence » avec normalisation de la gamme des 
valeurs [0-1]. 
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4.4.1.1 Synchronisation des fenêtres de visualisation, superposition 
dynamique et transparence 

 Cliquez sur « Tools > Link > Link Displays… » dans la barre de menu d’une des fenêtres 

de visualisation que vous voulez synchroniser. 

 Dans la fenêtre « Link Displays » qui apparait,  

o Changez les « NO » en « Yes » à l’aide des doubles flèches. Cette opération 

synchronise les fenêtres de visualisation sélectionnées. 

o Changez le « Off » en « On ». Cette opération permet une superposition 

dynamique des images des différentes fenêtres de visualisation 

synchronisées. 

o Indiquez une transparence (opacité en réalité) de 0 %. Cette opération permet 

de rendre la couche supérieure d’une fenêtre de visualisation transparente en 

cliquant dessus. 

o Ne modifiez pas le « Link Size / Position » 

o Cliquez « OK » 

Testez rapidement  la synchronisation de vos fenêtres à partir d’une « Scroll window » et la 

superposition dynamique à partir d’une « Image window ». 

4.4.1.2 Modification de la symbologie 

 Cliquez sur « Tools > Color Mapping > ENVI Color Tables… » dans la barre de menu 

d’une des fenêtres de visualisation dont vous voulez changer la symbologie. 

 Explorez les différents types de symbologie et choisissez une symbologie qui vous 

paraît idéale pour comparer les 2 images, par exemple, la symbologie « GRN-RED-

BLU-WHT » (Figure 9) 

 Répétez ces opérations pour l’autre fenêtre de visualisation. 

Comparez visuellement ces 2 images. Aidez-vous notamment du « Cursor Location / Value ». 

Avec la symbologie « GRN-RED-BLU-WHT », quelle couleur est associée à une faible / 

importante valeur de NDVI ? Que remarquez-vous ? Réfléchissez en termes d’évolution 

spatio-temporelle du NDVI (rem : au Burkina Faso, le mois de janvier fait partie de la saison 

sèche et le mois de septembre de la saison humide). Cette évolution est-elle la même 

partout en Afrique ? 

Pour améliorer la comparaison des ces 2 images par analyse visuelle, synchronisez les 2 

fenêtres de visualisation et utilisez une symbologie adéquate (voir ci-dessous).  
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NDVI – Normalized Difference Vegetation Index 

Le NDVI est un indice de végétation qui se définit comme la différence normalisée des mesures de 

réflectance spectrale acquises dans les zones de longueurs d’onde « Proche Infra-Rouge » (« PIR ») et 

« Rouge ».  

)(

)(

RougePIR

RougePIR
NDVI




  

 

Sa valeur théorique varie entre -1 et 1.  En pratique, une surface d’eau libre (océan, lac,…) prendra des 

valeurs de NDVI  proches de 0, un sol nu prendra des valeurs de 0.1 à 0.2, alors qu’une végétation 

dense aura des valeurs de 0.5 à 0.8. 

Explication physique du NDVI 

Les plantes vertes absorbent une grande partie des radiations solaires dans une zone de longueurs 

d’onde appelée « PAR » (« Photosynthetically Active Radiation »), dont fait partie la zone du 

« Rouge ». Par contre, le « PIR » est fortement diffusé (non absorbé : transmis et réfléchi) par la 

plante. Par conséquent, une plante verte vive apparait sombre dans le PAR (dont le rouge) car ces 

longueurs d’ondes sont absorbées par la plante (petite valeur de réflectance), et « brillante » dans le 

« PIR » car ces longueurs d’ondes sont réfléchies en partie (grande valeur de réflectance).  

   
 

Le NDVI est directement lié à l’activité photosynthétique des plantes et donc à la capacité 

d’absorbation énergétique de la canopée du couvert végétal. Il agit comme indicateur de la biomasse 

chlorophyllienne des plantes. En termes de réflectance dans le PIR et le Rouge, la neige et les nuages 

se comportent à l’inverse des plantes vertes.   

Figure 10 : Explication du NDVI – Normalisez Difference Vegetation Index 

Une végétation en bonne santé (gauche) absorbe 
la plupart de la lumière visible qui l’intercepte et 
réfléchi une partie importante de la lumière PIR.  
 
Une végétation en mauvaise santé ou clairsemée  
(droite) réfléchi plus de lumière visible et moins 
de PIR.  
 
Les chiffres de la figure ci-contre sont 
représentatifs de valeurs réelles mais la réalité 
est bien plus variée. 
 
(Illustration by Robert Simmon, NASA GSFC). 
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4.4.2 Analyse temporelle de « détection du changement » (« Change 
detection analysis ») (avec ENVI) 

L’analyse de détection du changement comprend de nombreuses méthodes dont le but est 

d’identifier, de décrire et de quantifier, les différences entre images d’une même scène 

(même endroit) prises à différents moments ou dans des conditions différentes.  

Avez-vous une idée des situations dans lesquelles ce genre d’analyse peut être utile ?  

Réponse : fonte des glaciers, tsunami, feu de forêt, glissement de terrain, variation 

saisonnière de la végétation 

Dans le « Help \ Start ENVI Help » menu, cherchez dans l’onglet « index » le « change 

detection \ substratcive » et rendez-vous à l’illustration en bas de page. A quoi cette 

situation pourait-elle correspondre ? Qu’en est-il de l’illustration se trouvant dans la 

rubrique « Change detection \ Principal Components » ? 

Vous allez maintenant utiliser l’un des outils les plus simples d’ENVI pour l’analyse de la 

détection du changement : « Compute Difference Map ».  

Pour des informations sur cet outil, utilisez le « Help \ Start ENVI Help \ Contents \ ENVI 

User’s Guide \ Basic Tools \ Change Detection \ Compute Difference Map ». Cet outil permet 

d’analyser le changement entre une paire d’images représentant un « stade initial » et un 

« stade final » (avant et après le changement). L’output résultant de cette opération est 

calculé en soustrayant l’image initiale de l’image finale (FINALE – INITIALE) (Figure ci-

dessous) et  consiste en une image classifiée dont les classes sont définies par des « seuils de 

changement ». Cette « image de changement » nous informe sur l’intensité du changement 

(absence de changement, changement « positifs » ou « négatifs ») et sur sa localisation dans 

l’espace.  

Jetez un œil dans la rubrique «Tips for Successful Analyses » du « change detection 

analysis ».  

Pour analyser le changement en termes de couverture végétale sur l’Afrique entre janvier 

2006 et septembre 2006 (Figure 9), réalisez les opérations suivantes : 

 Allez dans « ENVI main menu \ Basic Tools \ Change Detection \ Compute Difference 

Map” 

 Dans la fenêtre « Select the « Initial State » Image », sélectionnez l’image ante-

changement, dans ce cas-ci, l’image NDVI-Afrique 

« …\TELEDETECTION\DATA_TP_ENVI_ULg\SPOT VEGEATION 

AFRIQUE\decade1_JANVIER_2006.tif », et cliquez « OK » 
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 Dans la fenêtre « Select the « Final State » Image », sélectionnez l’image post-

changement, dans ce cas-ci, l’image NDVI-Afrique 

« …\TELEDETECTION\DATA_TP_ENVI_ULg\SPOT VEGEATION 

AFRIQUE\decade1_SEPTEMBRE_2006 », et cliquez « OK » 

 Dans la fenêtre « Compute Difference Map Input Parameters », choisissez, 5 classes.  

Plusieurs méthodes de calcul de changement s’offrent à vous. Vous allez essayez la méthode 

« Simple Difference » avec et sans preprocessing de normalisation : 

 La méthode « Simple difference » réalise une simple différence entre les valeurs de  

Digital Number (« DN ») des deux images. En comparant vos deux images à l’aide du 

« cursor / location value tool », faites-vous une idée sur la gamme de valeurs qui 

ressortira de cette analyse  avec les 2 images NDVI. 

 Le preprocessing « Normalize Data range (0 – 1) », réalise un prétraitement 

consistant en : « (DN – min) / (max – min) » qui réduit la gamme des valeurs de 

chaque image entre 0 et 1. En utilisant cette méthode, quelle gamme de valeurs 

ressortira de l’analyse de changement avec les 2 images NDVI ? 

 Dans la fenêtre « Compute Difference Map Input Parameters », adaptez les valeurs 

seuils (« treshold ») de vos 5 classes en fonction de la méthode choisie (une méthode 

à la fois). Choisissez d’enregistrer vos images résultats comme fichier dans le 

répertoire « …TELEDETECTION\DATA_TP_ENVI_ULg\SPOT VEGEATION 

AFRIQUE\difference_map\ » avec comme nom : SD_5class_xx_tresh ou 

SD_5class_Norm_xx_tresh. 

 Cliquez « OK » 

Ensuite, chargez vos « images de changement classifiées » dans de nouvelles fenêtres de 

visualisations que vous synchronisez avec les images de base (NDVI) et comparez. 

Commentez les résultats obtenus. 

 

 

 

 

 

 

 

 
Figure 11 : illustration de l’opération de soustraction algébrique de 2 images satellites 

avec des exemples de valeurs de pixels. 
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4.4.3 Analyse d’une série temporelle d’images NDVI basse résolution 
(avec WINDISP) 

Windisp fut originellement créé par la FAO (« Food and Agriculture Organisation »). Sa 

vocation principale est l’analyse et l’affichage de cartes et images satellites. En particulier, il 

permet un traitement de séries temporelles d’images. Pour plus d’information, voyez la page 

web http://www.fao.org/GIEWS/english/windisp/dl.htm où vous pourrez également 

télécharger ce logiciel gratuit. 

A l’aide de Windisp, vous allez visualiser l’évolution temporelle du NDVI pour le Pakistan, 

extrait à partir d’une série temporelle d’images SPOT Végétation  NDVI (« Normalised 

Difference Vegetation Index » : (NIR – RED) / (NIR + RED)), sur une période allant de janvier 

2005 à juin 2007. Il y a une image par décade (10 jours), soit 88 images au total. Chacune de 

ces images a été réalisée à partir de 10 images NDVI journalières, intégrées par MVC 

(« Maximum Value Compositing »). La résolution spatiale de ces images est d 1 km. 

 
Figure 12 : Evolution temporelle du NDVI pour un pixel du Nord Pakistan  sur une image SPOT 

Végétation dans Windisp 

 

Les données nécessaires à cet exercice sont dans le dossier « SPOT VEGETATION PAKISTAN ». 

Ouvrez Windisp : cliquez sur Démarrer > Tous les programmes > Windisp5.1 >  

Fermez la fenêtre « About » si celle-ci ne disparait pas automatiquement. 

Pour ouvrir une image, 

 Cliquez sur « File > Open > Image » dans la barre de menu principale.  

Dans la fenêtre « File Open Image » qui s’ouvre,  

http://www.fao.org/GIEWS/english/windisp/dl.htm
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 A l’aide du bouton « … » à droite de la ligne « Image name », naviguez jusqu’à une 

image SPOT VGT NDVI Pakistan de type « DV05012.pak » dans le répertoire « SPOT 

VEGETATION PAKISTAN ».  

Le nom (« DV05012 ») de ces fichiers-images est très structuré. Selon vous, quelle en est la 

signification ?  

Réponse : DV = 2 lettres de référence au choix, 05 = l’année, 01 = le mois, 2 = la décade du 

mois (de 1 à 3)). 

Pour afficher les données dans Windisp, vous avez besoin d’une « table de couleur » ou 

« Color table », qui fait le lien entre les valeurs des pixels de l’image et la couleur à afficher 

dans le viewer de Windisp (similaire à un fichier « .lyr » de symbologie d’ArcMap). 

 A l’aide du bouton « … » à droite de la ligne « Color table », naviguez jusqu’à la table 

de couleur pour image NDVI :dans le répertoire « \SPOT VEGETATION PAKISTAN\ 

NDVI.CLR ».  

 Cliquez « OK » 

L’image NDVI SPOT VGT, ainsi que la légende s’ouvrent dans votre viewer. Cette image est 

centrée sur le Pakistan, mais le Pakistan n’est pas clairement identifiable.  

 Cliquez sur « File > Retrieve > ArcView Shape » dans la barre de menu principale. 

 Dans la fenêtre « File Retrieve ArcView Shape » qui  apparait, à la ligne « ArcView 

Shapefile », naviguez jusqu’au fichier Shapefile du Pakistan dans le répertoire 

« \SPOT VEGETATION PAKISTAN\SHAPE_PAKISTAN\PAKISTAN.shp ». 

 Laissez les autres options par défaut (options d’affichage du shapefile) 

 Cliquez « OK » 

 Les frontières du PAKISTAN se superposent à l’image NDVI. Lorsque vous déplacez 

votre souris sur l’image,  les 3 premiers rectangles du coin inférieur gauche du viewer 

renseignent sur les coordonnées du pixel sélectionné. Il s’agit des coordonnées 

écran, image et géographiques respectivement. Le 4ème rectangle vous renseigne 

sur la valeur NDVI du pixel. 

Analysez visuellement votre image. A quoi correspondent de faibles / fortes valeurs de 

NDVI ? Quelle est l’évolution spatiale du NDVI ? Tentez de l’expliquer.   

Utilisez le bouton « Histogram »  dans la barre d’outils de Windisp pour accéder à la 

distribution des valeurs de « Digital Number » (DN, valeur digital des pixels) de l’image. La 

conversion entre DN et valeur de NDVI se fait par une formule mathématique de type 

« NDVI = a*DN + b » (Figure 13). Cette relation est visible / modifiable dans le « Header file » 

du fichier-image. Pour y accéder, allez dans « Processe > Header > Edit », choisissez le fichier 
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d’intérêt et cliquez « OK ». Les valeurs des coefficients a et b susmentionnés correspondent 

aux lignes « Values slope » et « Values intercept » respectivement. 

 

Figure 13 : Conversion of DN to NDVI values 

 

Windisp permet de visualiser l’évolution temporelle des valeurs de NDVI en un point à partir 

d’une série temporelle d’images. Cette application requière l’existence d’une 

« liste chronologique» de fichiers-images dans un fichier de type « list file.lst ». 

 Cliquez « View > Graph > Image Series » dans la barre de menu principale. 

Vous devez indiquez l’emplacement du fichier « liste », ou le créer s’il n’existe pas, dans la 

fenêtre « View Graph Image Series » qui apparait. 

 Cliquez sur « … » de cette fenêtre. 

L’assistant de création d’un fichier liste apparait dans la fenêtre « List Builder – [new]» 

 Cliquez sur « File > New », pour créer un nouveau fichier. 

 Entrez « 88 » comme nombre de lignes que devra comporter le fichier-liste, dans la 

fenêtre « New Filenames List ». 

 Cliquez « OK » 

 Entrez « 1 » comme nombre de colonnes 

 Cliquez « OK » 

 Cliquez sur « FileS > Add », pour ajouter la série temporelle de fichiers-images à votre 

fichier liste en cours de création. 

 Naviguez jusqu’à votre série temporelle de fichiers-images à l’aide de la fenêtre 

« Select one or more files to add to the list ». Elles se trouvent dans le répertoire  «  » 

 Sélectionnez tous les fichiers-images de type « DV0xxxx.pak ». Attention, n’incluez 

pas dans votre liste le fichier « NDVI.CLR ». 

 Cliquez « OK » 

Votre fichier liste s’affiche dans la fenêtre « List Builder – [new] » 
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 Cliquez sur « File > Save As » pour enregistre votre fichier-liste dans le répertoire 

«  \SPOT VEGETATION PAKISTAN » sous le nom « LISTE_VOTRE_NOM.lst » 

 Fermez la fenêtre « List Builder – [new] » à l’aide de la croix rouge 

 Cliquez « OK » dans la fenêtre « View Graph Image Series » 

Une fenêtre « Graph – ImageSeries » apparait dans le viewer de Windisp.  

 Cliquez sur un pixel au choix de votre image NDVI. 

L’évolution temporelle du NDVI (entre 2005 et 2007) pour ce pixel apparait dans la fenêtre 

« Graph – ImageSeries ». 

Analysez et commentez l’évolution temporelle du NDVI en différents endroits du Pakistan.  

Réfléchissez également à la relation résolution spatiale (1 km), résolution temporelle (1 jour) 

et recouvrement spatial des images SPOT Végétation. 

Fermez Windisp et retournez dans ENVI. 

4.5 Création d’un indice NDVI à partir d’une image 
Landsat TM 

Envi propose un outil pratique pour créer un indice NDVI à partir de bandes de réflectance 

dans le rouge et le proche-infrarouge : « NDVI Calculation Parameters ». 

 Cliquez sur « Transform > NDVI » dans la barre de menu principale d’ENVI. 

 Sélectionnez l’image Landsat TM « can_tmr.img » dans la fenêtre « NDVI Calculation 

Input File » qui apparait. 

 Cliquez « OK » 

 Choisissez « Landsat TM »  comme « Input File Type » dans le menu déroulant 

 Indiquez le numéro des bandes qui correspondent aux longueurs d’onde Rouge et 

Proche Infra Rouge, bandes numéro 3 et 4 respectivement 

 Sauvez votre résultat dans un fichier (« File ») dans le répertoire « RESULTAT » 

 Choisissez « Floating Point » comme « Output Data Type » 

 Cliquez « OK » 

Votre bande NDVI « NDVI_calcul » apparait dans la fenêtre « Available Bands List ». 

 Chargez-la dans une nouvelle fenêtre de visualisation. 

Comparez cette image avec la composition colorée vrai couleur. Que constatez-vous ? 

Comment apparaissent neige,  végétation et sol nu ? Les valeurs de NDVI sont accessibles via 

l’outil « Cursor Location / Value ». Donnez une valeur de NDVI moyenne des 3 types 

d’occupation du sol sus-mentionnées. 
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Une autre possibilité pour créer un indice NDVI, ou toute autre combinaison de bandes, est 

donnée par l’outil « Band Math ». 

 Cliquez sur « Basic Tools > Band Math », pour y accéder. 

Ensuite il vous suffira de taper une expression du type « b4 – b3 » dans la fenêtre « Enter an 

expression », de cliquez « Add to List », de la sélectionner, de définir par sélection les bandes 

correspondant à b4 et b3 et de choisir un « output file ». 

Fermez toutes les fenêtres de visualisation. 

4.6 Visualisation 3D d’un Modèle Numérique de 
Terrain (MNT) 

Dans cette section, vous travailler avec un Modèle Numérique de Terrain (MNT) du monde. 
 
Ouvrez le MNT du monde dans un nouveau viewer : 

 Cliquez sur « File > Open Image File… » dans la fenêtre « Available Band List » 

 Naviguez jusqu’au répertoire où se situe votre MNT, dans ce cas-ci, “C:\Program 

Files\RSI\IDL63\products\envi45\data\worl_dem » 

 Sélectionnez-le et cliquez « Open » 

Le fichier « world_dem » s’ajoute dans la fenêtre « Available Band List ». Il est composé de 2 

bandes correspondant aux élévations minimale et maximale. Accédez aux informations 

disponibles sur ce fichier dans la rubrique « Map Info » de cette couche. 

 Chargez la bande d’élévation maximale dans un nouveau viewer. 

Pour une meilleure visualisation, changez la symbologie noir et blanc actuelle en un 

symbologie colorée : 

 Cliquez sur « Tools > Color Mapping > ENVI Color Tables… » dans la barre de menu de 

la fenêtre de visualisation. 

 Explorez les différents types de symbologie et choisissez une symbologie qui vous 

paraît adéquate. Par exemple, la symbologie « Eos A » 

Visualiser l’entièreté du monde en 3D sans exagération verticale (multiplication de l’altitude 

par un facteur > 1) ne serait pas très intéressant car la variation verticale de la surface 

terrestre (élévation entre 0 et 8 km) est insignifiante face à l’étendue horizontale du monde 

(circonférence de la terre d’environ 40 000 km). De plus, si vous vous intéressez à une région 

particulière du monde, par exemple, l’Himalaya, vous choisirez de réaliser un « Spatial 

Subset » (sélection d’une région particulière) centré sur l’Himalaya. 
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 Cliquez sur « Tools > 3D SurfaceView… » dans la barre de menu de la fenêtre de 

visualisation dans laquelle se situe votre MNT 

 Sélectionnez la bande « Maximum Elevation » dans la fenêtre « Associated DEM 

Input File ».  

Les informations sur cette bande apparaissent dans la colonne « Band Information » de cette 

fenêtre. 

 Cliquez « OK » 

La fenêtre « 3D SurfaceView Input Parameters » apparait.  

 Indiquez une exagération verticale de 600 si vous voulez visualiser la totalité du 

monde en 3D, ou une exagération de 100 si vous vous  concentrez sur l’Himalaya. 

 Réalisez éventuellement un « Spatial Subset » (si vous vous concentrez sur une région 

particulière) à l’aide de l’option « Image » qui vous permet de sélectionner 

directement la région d’intérêt sur la carte du monde. Laissez la valeur par défaut de  

400 colonnes * 400 lignes mais ajustez la position du « subset » sur l’Hymalaya 

 Cliquez « OK » 2 fois. 

Votre surface 3D apparait après quelques secondes dans la fenêtre « 3D SurfaceView (Vert 

Exag : 600.0 (ou 100)) ». Explorez votre MNT. Eventuellement, créez un nouvel MNT pour 

une autre région du monde avec une autre symbologie. 

 
Figure 14: Vue 3D du monde obtenue à l’aide de l’outil 3D « SurfaceView » d’ENVI. 

 
ENVI permet également de visualiser des images satellites en 3D pour peu que vous 

possédiez une image et un DEM géoréférencés et couvrant la même zone (la partie 

commune à l’image et au DEM sera représentée en 3D). Ceci est réalisé dans la section 

4.8.1.2 « Observation d’une image en 3D » below. 
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4.7 Correction géométrique 

Les images satellites, telles qu’enregistrées par les capteurs des satellites, présentent 

souvent des erreurs dites « géométriques ». Deux  grands types d’erreurs sont à distinguer : 

 Erreurs systématiques (liées au système d’enregistrement de l’image, dues à la 

rotation de la terre, à l’angle de balayage…). Ces erreurs, à condition de posséder 

suffisamment d’informations sur la position du capteur, angle de prise de vue, etc,   

peuvent être corrigées par « Orthorectification ». 

 Erreurs accidentelles (causes fortuites, mouvements incontrôlés du satellite par 

rapport à sa ligne orbitale et à la verticale du lieu, variation d’altitude). Ces erreurs ne 

sont pas connues à priori, et ne peuvent donc être corrigées par orthorectification. La 

correction appliquée est de type « géoréférencement simple » et utilise des points de 

positionnement (points de calage) connus facilement retrouvables sur l’image à 

corriger. 

Ces erreurs géométriques peuvent avoir comme conséquences des erreurs de 

positionnement de l’image mais aussi des erreurs dans l’estimation des superficies dues 

aux déformations de l’image.  

Dans le cadre de ce TP, vous réaliserez une correction géométrique par géoréférencement 

simple. 

 Ouvrez les images suivantes dans 2 nouveaux viewer 

o  « SPOT10mNamurBAND1.img » (Viewer 1) 

o « SPOT10mNamurNONGEO.tif » (Viewer 2) 

L’image « SPOT10mNamurNONGEO.tif » est identique à l’image « SPOT10mNamur.tif », si ce 

n’est qu’elle présente une déformation géométrique. Il s’agit d’un décalage spatial non 

connu précisément. Vous allez donc devoir la géoréférencer. ENVI propose plusieurs 

méthodes pour réaliser ce type d’opération en fonction du type de donnée utilisée pour le 

positionnement de référence (une image, une carte, des points de contrôle issus de GPS,…). 

Dans ce cas-ci, vous allez géoréférencer votre image « SPOT10mNamurNONGEO.tif » à l’aide 

de l’image « SPOT10mNamurBAND1.img » qui elle est correctement géoréférencée. 

Constater l’erreur de positionnement de votre image « SPOT10mNamurNONGEO.tif » : 

 Cliquez sur « Tools > Link > Link Display… » dans la barre de menu d’une fenêtre de 

visualisation et synchronisez vos 2 fenêtres de visualisation en activant la 

superposition dynamique et choisissez une transparence de 0 %. 
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 Zoomez sur un endroit très caractéristique de votre image, par exemple, la jonction 

entre la Sambre et la Meuse dans le centre de Namur. Arrangez vous pour avoir cette 

jonction dans le coin inférieur droit de votre viewer 2. 

 Cliquez sur le viewer image 2. 

L’image de référence (viewer 1) devrait apparaitre dans le viewer 2 lorsque vous cliquez 

dessus. Constatez le décalage spatial entre ces 2 images.  

 Cliquez sur « Tools > Link > Unlink Display » pour ne plus synchroniser les viewer, ce 

qui serait gênant pour la géoréférenciation. 

Pour géoréférencer votre image « SPOT10mNamurNONGEO.tif », 

 Cliquez sur « Map > Registration > Select GCPs : Image to Image » 

 Indiquez le display 1 comme le display contenant l’image de référence (« Base 

image ») et le display 2 comme le display contenant l’image à géoréférencer. 

 Cliquez « OK » 

Une fenêtre « Ground Control Point Selection » apparait. C’est à l’aide de cette interface que 

vous allez géoréférencer l’image en créant des points de contrôle au sol ou « Ground Control 

Point » (« GCP »).  

 Cliquez sur « Show List » pour afficher la liste de GCP existant, et ouvrez cette fenêtre 

complètement (vers la gauche) 

Pour l’instant elle est vide.  

 Sélectionnez un endroit très clairement visible et identifiable (au pixel près !) dans 

l’image de référence (viewer 1) (par exemple la pointe de terre à la jonction de la 

Sambre et de la Meuse) 

 Sélectionnez le pixel correspondant dans l’image à corriger 

 Cliquez sur « Add Point » pour enregistrer ce premier GCP. Il s’ajoute dans votre table 

de GCP. 

Lors de la saisie de GCP, ENVI calcul l’erreur quadratique moyenne (« Root Mean Square 

Error » ou « RMSE ») à partir de 5 GCP (à droite dans la table). En principe, cette erreur doit 

être inférieure à la taille d’un pixel de l’image à géoréférencer, ici 10 mètres. Dans votre cas, 

pour une question de rapidité, tolérez un RMSE de 20 mètres. Supprimez les points qui 

présentent un RMSE trop important. Gardez un quinzaine de points GCP au final. 

 Choisissez dans ce cas-ci une correction géométrique au premier degré. 

Lorsque vous avez suffisamment de points et que le RMSE est suffisamment petit, 

 Cliquez sur « Option > Warp File (as Image to Map)… » dans la fenêtre « Ground 

Control Point Selection » 
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 Sélectionnez l’image  « SPOT10mNamurNONGEO.tif » et cliquez « OK » dans la 

fenêtre « Input Warp Image » 

 Dans la fenêtre « Registration Parameters », choisissez une transformation 

polynomiale de degré 1, avec un ré-échantillonnage du plus proche voisin, et 

enregistrez votre fichier output dans le dossier « RESULTAT »  

 Cliquez « OK » 

Votre image géoréférencée apparait dans la fenêtre « Available Bands List » 

 Analysez votre résultat par superposition dynamique avec l’image de référence dans 

un nouveau viewer. 
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4.8 Réalisation d’une carte d’occupation du sol par 
classification supervisée d’une image SPOT 
multispectrale 

Dans cette section, vous allez réaliser une carte d’occupation du sol par classification 

supervisée d’une image satellite SPOT  de la région de Namur. L’image SPOT dont vous allez 

avoir besoin se situe dans le répertoire «...\DATA_TP_ENVI_ULg\SPOT NAMUR\». 

Les grandes étapes à suivre sont : 

1. Observation de l’image 

2. Classification supervisée de l’image 

3. Validation des résultats de la classification 

4. Production de la carte d’occupation du sol dérivée de la classification 

4.8.1 Observation d’une image 

4.8.1.1 Observation d’une image en 2D 

Ouvrez l’image « SPOT10mNamur.tif » dans un nouveau viewer en « RGB » en sélectionnant 

les bandes de votre choix. Cette image est issue du capteur SPOT4 ou SPOT5. Ces principales 

caractéristiques sont reprises dans le tableau ci-dessous. 

Nom de la bande Longueur d’onde Spectre électromagnétique Résolution spatiale 

B1 0.50 - 0.59 µm Vert et Jaune 10 mètres 

B2 0.61 - 0.68 µm Rouge 10 mètres 

B3 0.78 - 0.89 µm Proche InfaRouge (PIR) 10 mètres 

B4 1.58 - 1.75 µm Moyen InfraRouge (MIR) 10 mètres 
Figure 15: caractéristiques de l’image SPOT 

4.8.1.2 Observation d’une image en 3D 

Pour visualiser l’image en 3D (Figure 16: Visualisation 3D de la ville de Namur (centre ville, Meuse, 

citadelle, campagne alentour) à l’aide d’une image SPOT et d’un DEM (ASTER GDEM).Figure 16), un 

MNT correspondant à la zone de l’image est nécessaire. La partie commune à l’image et au 

DEM sera représentée en 3D. Le MNT nécessaire à cet exercice est fourni dans le dossier 

« DATA_TP_ENVI_ULg\ASTGTM_N50E004\ASTGTM_N50E004_dem.tif ». 

 Ouvrez l’image « SPOT10mNamur.tif » dans une nouvelle fenêtre de visualisation 

(confer ci-dessus) 
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 Utilisez le menu « 3D SurfaceView » de la fenêtre de visualisation dans laquelle 

l’image est ouverte (confer section 4.6) et utilisez le MNT 

« ASTGTM_N50E004_dem.tif».  

 Adapter les paramètres de visualisation, avec par exemple : 

o Une exagération verticale de 5 

o Un « spatial subset » centré sur le centre ville de Namur et la citadelle 

Remarquez que ce type de représentation, combinant les informations spectrales et 

l’altitude, aide à la compréhension et à l’analyse de l’organisation de l’espace, et facilitera en 

particulier votre photo-interprétation. 

 
Figure 16: Visualisation 3D de la ville de Namur (centre ville, Meuse, citadelle, campagne alentour) 

à l’aide d’une image SPOT et d’un DEM (ASTER GDEM). 

 

4.8.1.3 Identification des classes d’occupation du sol 

Analyser visuellement votre image et repérez les grands types d’occupation du sol : 

 Centres urbains (ville et village, bâtiments, gare, …) 

 Routes (autoroute, route, rail) 

 Zones boisées (forêt, bois,…) 

 Terres agricoles (champ cultivé et champ nu) 

 Cours d’eau (fleuves, canaux,…) 
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 Carrière 

 … 

Décidez des classes que vous essayerez de retrouver par classification automatique de 

l’image (entre 5 et 8 classes). 

4.8.1.4 Utilisation de données complémentaires pour l’analyse visuelle d’une 
image 

La photo-interprétation (reconnaissance des différentes occupations du sol par analyse 

visuelle) d’une image est parfois difficile : 

 Soit parce que l’image ne présente pas une qualité suffisante (résolution spatiale et 

spectrale adéquate), 

 Soit à cause d’un manque d’expérience du photo-interpréteur ou d’un manque de 

connaissance de la zone.  

La photo-interprétation peut être facilitée grâce à l’utilisation de données complémentaires 

sur la zone étudiée, par exemple : 

 Analyse visuelle de la zone dans Google Earth. Google Earth dispose d’image à très 

haute résolution spatiale pour une partie sans cesse grandissante de la planète. 

Attention toutefois à garder à l’esprit que les images de Google Earth ne datent 

probablement pas de la même période que celle qui fait l’objet de votre étude. Par 

exemple, la reconnaissance des types de forêt au Sud de Namur se fait facilement 

dans Google Earth (feuillus versus résineux). 

 Cartes topographiques 

 Une enquête de terrain avec relevé GPS 

 Divers documents donnant des informations sur l’occupation du sol de la zone. 

4.8.1.5 Outil « Animation » 

L’outil « Animation » permet d’afficher automatiquement, successivement et à une certaine 

vitesse les différentes bandes d’un fichier-image. 

 Cliquez sur « Tools > Animation… » 

 Sélectionnez les 4 bandes de l’image SPOT 

 Cliquez « OK » 

Une fenêtre animée apparait. Modifiez en la vitesse si nécessaire. Qu’est-ce que cet outil 

permet de mettre clairement en évidence ? 
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Réponse : la forte différence de valeur de réflectance selon les bandes pour une même 

occupation du sol. 

4.8.1.6 Amélioration de contraste 

L’amélioration de contraste  consiste en une transformation virtuelle des données afin 

d’utiliser toute la gamme d’intensité de couleur disponible (256 niveaux) pour visualiser les 

données à l’écran. Cette amélioration ne modifie donc pas vos données sources (la valeur 

des pixels). Elle ne fait qu’attribuer différemment la palette de couleur disponible à votre 

image afin de faire ressortir certains éléments plus clairement. 

L’amélioration de contraste proposée par ENVI par défaut est de type linéaire et se base sur 

la fenêtre « Scroll » reprenant l’ensemble de l’image. 

Tentez de trouver une amélioration de contraste qui vous facilite l’interprétation visuelle de 

l’image : 

 Cliquez sur « Enhance » dans la barre de menu du viewer. 

Vous avez le choix entre différentes améliorations de contraste prédéfinies, à appliquer sur 

chacun des 3 types de viewer (Image, Scroll et Zoom). Vous pouvez également réaliser une 

amélioration de contraste manuellement de manière interactive (« Interactive Stretching »). 

Des filtres sont également disponibles (« Filter »).  

4.8.2 Classification d’une image 

Il existe différents types de méthodes de classifications :  

 Supervisée : l’opérateur défini lui-même les classes à produire (nombre, 

caractéristique spectrale,…)  

 Non-supervisée : le logiciel défini lui-même les classes 

 

 Par pixel : chaque pixel est classifié individuellement et indépendamment des pixels 

voisins 

 Par objet : l’image est d’abord découpée en objet (1 objet = 1 ensemble de pixels 

voisins spectralement homogène) au cours d’une étape de « segmentation ». 

Ensuite, les caractéristiques de ces objets sont utilisées pour les classifier. 

4.8.2.1 Classification non-supervisée 

Réalisez 2 classifications non-supervisées de votre image. Une classification « Iso-Data » et 

une classification « K-means ». 



 39 

 Cliquez sur « Classification > Unsupervised > Iso-Data et puis K-means » 

 Sélectionnez votre image géoréférencée comme image à classifier 

 Laissez la plupart des paramètres par défaut.  

 Enregistrez le résultat dans votre dossier « Résultat » avec comme nom, le nom de la 

méthode utilisée. 

Visualisez les 2 classifications dans 2 nouveaux viewer et commentez-les (nombre de classes, 

type d’occupation du sol reconnus, mélangés, etc). 

4.8.2.2 Classification supervisée 

Réaliser une classification supervisée d’une image satellite sous entend que vous possédez 

une très bonne connaissance de l’occupation du sol réelle de la zone de l’image à l’époque 

où l’image a été prise. Cette connaissance peut venir de plusieurs sources comme expliqué 

ci-dessus à la section 4.8.1.4 « Utilisation de données complémentaires pour l’analyse 

visuelle d’une image ».  

Dans ce cas-ci, comme il n’y a pas eu d’enquête de terrain, vous procéderez par photo-

interprétation en vous aidant éventuellement de Google Earth pour les classes les plus 

difficilement reconnaissables.   

4.8.2.2.1 Définition de la légende de la carte (taxon) 

A partir de l’examen de la composition colorée de la zone à classifier (également avec 

l’amélioration de contraste), et de votre connaissance de la région étudiée, définissez la 

légende de la carte, c’est-à-dire les classes d’occupation du sol que vous désirez voir 

apparaitre dans la carte d’occupation du sol qui sera produite. 

4.8.2.2.2 Définition du nombre de classes spectrales 

A partir de l’examen de la composition colorée de la zone à classifier (également avec 

l’amélioration de contraste), identifiez également combien de signatures spectrales 

différentes correspondent à chaque taxon de la légende. En effet, une occupation du sol 

telle que « culture » peut présenter différentes signatures spectrales au moment de 

l’enregistrement de l’image, selon l’espèce cultivée et son stade végétatif. Il s’agit donc de 

définir autant de classes spectrales qu’il existe de situations spectralement bien différentes 

pour chaque occupation du sol. L’algorithme de classification pourra ainsi traiter chaque 

signature spectrale de manière indépendante.  
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L’examen des signatures spectrales de chaque classe spectrale peut se faire dans ENVI à 

l’aide des aires d’entrainement (confer ci-dessous la section 4.8.2.2.3) et de l’analyse de leur 

séparabilité (confer section 4.10 « Séparabilité spectrale des classes d’occupation du sol sur 

une image »). 

Les différentes classes spectrales appartenant à un même taxon d’occupation du sol 

pourront être fusionnées après la classification pour une meilleure représentation 

cartographique (confer ci-dessous la section 4.8.4 « Post-traitement d’une image classifiée 

pour améliorer le rendu visuel »). 

Dans ce cas-ci, pour vous faciliter la tâche, créez 5 classes maximum. 

4.8.2.2.3 Sélection des aires d’entrainement ou « ROI – Region Of Interest» 
pour chaque classe 

Il s’agit de sélectionner un minimum de 30 pixels spectralement représentatif  de chaque 

signature spectrale identifiée précédemment. Ces échantillons, ou « aires d’entrainement » 

serviront à la « CALIBRATION » de votre classification. Elles sont définies à l’écran par la 

numérisation d’un ou plusieurs polygones pour chaque classe spectrale. Sur base des 

polygones ainsi définis, l’extraction automatique des valeurs de pixels contenues à l’intérieur 

des polygones et le calcul de leur moyenne et écart-type produiront la signature spectrale de 

chaque classe à partir des 3 canaux de l’image SPOT. 

Les aires d’entrainement doivent être représentatives de chaque classe spectrale 

considérée. Voici quelques conseils pour la sélection des aires d’entrainement : 

 Il est souvent préférable que ces aires d’entrainement soient bien réparties sur toute 

l’image. En effet, ceci permettra de prendre en compte : 

o Les éventuels gradients de luminosité entre les différentes zones de l’image 

(conditions atmosphériques, relief/exposition,…) 

o Une légère différence spectrale entre une même classe d’occupation du sol 

dans des régions différentes (gradient ou classes pédologiques, variation des 

espèces végétales ou de leur état de développement, etc). 

o … 

 Un minimum de 30 pixels par classe spectrale et un nombre suffisant d’aires 

d’entrainement pour qu’elles soient représentatives de la classe considérée. Le 

nombre d’aires d’entrainement nécessaire dépendra donc de la complexité spectrale 

de chaque classe et de la complexité de l’image. Par exemple, une image ne 

comprenant comme occupation du sol que  le désert et la mer sera extrêmement 
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facile à classifier et cela pourra se faire avec peu d’aires d’entrainement. A l’inverse 

une image d’une zone agricole africaine présentera une beaucoup plus grande 

complexité d’occupation du sol (parcelles avec différentes cultures à différents 

stades de développement, différents états de sol et différents sols, arbres dans les 

parcelles, etc) et nécessitera l’utilisation de nombreuses aires d’entrainement afin 

qu’elles soient bien représentatives de toutes les variations d’une classe spectrale 

donnée. 

 La courbe de la distribution du nombre de pixels en fonction de leur réflectance 

(pour une bande spectrale donnée) doit être uni-modale (ou s’en rapprocher). Si elle 

est multimodale, ceci constitue une indication que ces aires correspondent à 

plusieurs classes spectralement distinguables et qu’il faut donc les séparer en autant 

de classes qu’il n’y a de mode dans la courbe. 

 Ne considérer que des « pixels purs », c’est-à-dire des pixels correspondant 

uniquement à la classe d’occupation du sol visée et non des pixels couvrant plusieurs 

classes d’occupation du sol  (« mixel » : pixel mixte). Par exemple, pour des zones 

d’entrainement d’un fleuve, ne pas considérer des pixels se trouvant proche de la 

berge car leur réflectance risque d’être influencée par la berge. 

Faites attention à faire apparaitre la mention « cal » dans le nom de ces classes qui seront 

utilisées à des fins de calibration (par exemple : « forêt_cal »), et ce afin de facilement faire la 

distinction entre vos classes de calibration et de validation lors de la création de la matrice de 

confusion (voir plus loin). 

4.8.2.2.4 Création de ROIs dans ENVI 

La définition des aires d’entrainement dans ENVI se fait via la création de « ROI » (« Region 

Of Interest ». Pour créez des ROIs : 

 Cliquez-droit sur l’image à classifier lorsqu’elle est affichée dans un viewer 

 Choisissez « ROI Tool… » 

La fenêtre « ROI Tool » apparait (Figure 17). C’est l’assistant de création des ROIs. 

 Dans cette fenêtre, choisissez la fenêtre « Image » comme zone de création des ROIs. 

 Nommez votre première région « foret » par exemple, et choisissez une couleur vert 

foncé 

 Dans la fenêtre Image, à l’aide de clic-gauche de la souris, créez un polygone autour 

d’une première zone représentative de la forêt. Pour terminer le polygone, faites 2 

clic-droit. 



 42 

 Répétez cette opération pour un certain nombre de polygones de cette classe jusqu’à 

ce que vous jugiez avoir un nombre représentatif de pixels « forêt » enregistrés 

comme ROI. 

 Pour ajouter une nouvelle classe, cliquez sur « NewRegion » 

 

 

Figure 17 : Classification supervisée d’une image dans ENVI : à gauche : image satellite et aires 
d’entrainement (« ROIs ») (polygones verts) ; au centre : image classifiée avec une symbologie 
adéquate; à droite : table des aires d’entrainement (« ROI Tool ») avec des aires pour chaque 
classe d’occupation du sol en calibration et validation.  

 
Construisez petit à petit vos ROI pour vos 5 classes d’occupation du sol. Une fois toutes vos 

ROI réalisées, sauvez-les dans un fichier 

 Cliquez sur « File > Save ROIs… » 

 Sélectionnez toute vos ROI 

 Enregistrez les dans un fichier « ROI.roi » dans votre dossier résultat. 

Répétez toutes ces opérations pour créer un nouveau fichier de ROI qui servira pour la 

VALIDATION de votre classification. Faites attention à faire apparaitre la mention « val » 

dans le nom de ces classes seront utilisées à des fins de validation (par exemple : 

« forêt_val »). Attention, cette opération ne peut être réalisée que parce que vous êtes 

confient à 100 % dans votre photo-interprétation. Nommez-le « ROI_VAL.roi » dans votre 

dossier résultat. 

 Fermez cet assistant de création lorsque vos deux fichiers ROI ont été créés. 
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4.8.2.2.5 Classification d’une image (classification supervisée) 

Pour classifier l’image de manière supervisée : 

 Cliquez sur « Classification > Supervised > Maximum Likelihood » dans la barre de 

menu principale d’ENVI. 

 Sélectionnez l’image à classifier (votre image géoréférencée) 

 Dans l’onglet « Open > ROI Files… », Sélectionnez votre fichier ROI de calibration 

« Roi.roi ». 

 Cliquez « OK » 

 Dans la fenêtre « Maximum Likelihood Parameters »,  sélectionnez toutes les classes, 

enregistrez votre classification comme fichier « CLASSIF_SUP » dans votre dossier 

« Résultats » et désactivez l’ »Output Rule Images » 

 Cliquez « OK » 

La classification se réalise. L’algorithme de classification selon le maximum de vraisemblance 

(« Maximum Likelihood ») est appliqué à tous les pixels de l’image sur base des paramètres 

statistiques décrivant chaque signature spectrale obtenue. La comparaison entre les valeurs 

de chaque pixel et les signatures spectrales des différentes classes déterminera la 

probabilité d’appartenance du pixel à chacune des classes. La classe présentant la 

probabilité maximum sera attribuée au pixel considéré. Le résultat apparait dans la fenêtre 

« Available Band List ». 

 Visualisez votre résultat dans un nouveau viewer. 

 Comparez ce résultat avec l’image de base par lien dynamique synchronisé des 

viewer (Figure 17). 

Cette comparaison vous permet d’identifier les défauts éventuels de votre classification et 

donc de l’améliorer. 

4.8.3 Validation de la classification supervisée : matrice de confusion 

Idéalement la définition des aires qui serviront à la validation d’une classification supervisée 

doit se faire de manière aléatoire afin de ne pas tronquer la validation. En effet, l’opérateur 

aura naturellement  tendance à choisir pour la validation des zones qu’il peut facilement 

photo-interpréter et qui sont probablement plus facilement classifiables que d’autres. Ceci  

aura pour conséquence de fausser les résultats de la validation en présentant une précision 

de classification meilleure que celle réellement obtenue. 

Dans la cadre de ce TP, par soucis de rapidité et de simplification, les ROIs de validation sont 

dessinés manuellement selon la même procédure que pour les ROIs de calibration (confer ci-

dessus). 
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Le fichier « ROI de validation » servira à la validation de la classification produite (mesure de 

la précision de la classification). La comparaison entre l’occupation du sol classifiée ou 

« prédite » et l’occupation du sol photo-interprétée (ROI de validation) est réalisée par la 

construction et la discussion d’une matrice de confusion (ou table de contingence). En 

principe le nombre de point / pixel pour réaliser la calibration et la validation de l’image doit 

suivre des règles statistiques, ce que vous n’aurez pas nécessairement suivi dans ce cas-ci. 

 Cliquez sur « Classification > Post Classification > Confusion Matrix > Using Ground 

Thruth ROI » 

 Sélectionnez l’image classifiée et le fichier ROI de validation avec l’onglet « Open » 

 Dans la fenêtre « Match Classes Parameters », créez les liens entre les ROIs de 

validation (par exemple: « forêt_val ») et de calibration (par exemple: « forêt_cal »). 

 Cliquez « OK »  

La matrice de confusion apparait. 

Deux exemples de matrice de confusion (structure, interprétation et définition des 

paramètres calculés) sont donnés en Annexe 2 et 3. 

4.8.4 Post-traitement d’une image classifiée pour améliorer le rendu 
visuel 

Plusieurs opérations de post-traitement peuvent être appliquées sur une image classifiée en 

vue d’en améliorer le rendu visuel par exemple. Pour une information détaillée sur les 

opérations de post-traitement, référez-vous à l’aide d’ENVI (Index : « Post classification »).  

Voici 3 opérations qui permettent d’améliorer le rendu visuel d’une image classifiée : 

 Pour diminuer l’effet poivre et sel typique d’une classification par pixel, utilisez une 

analyse majoritaire via le menu « Classification > Post Classification > 

Majority/Minority Analysis ». 

 Pour fusionner différentes classes (par exemple 2 classes se rapportant à la même 

utilisation du sol (agriculture) mais ayant des signatures spectrales différentes (terre 

labourée et champ de maïs) utilisez le menu « Classification > Post Classification > 

Combine Classes ». 

 Pour changer les couleurs de certaines classes, utilisez le menu “Tools > Color 

Mapping > Class Color Mapping ». Choisissez des couleurs intuitives pour chacune 

des classes (par exemple : vert foncé pour la classe « forêt », bleu pour la classe 

« eau », etc.) 
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4.8.5 Réalisation d’une carte d’occupation du sol – Mise en page 
cartographique 

Il est possible de réaliser une mise en page cartographique simple dans ENVI. Cependant un 

logiciel comme ArcMap (ArcGIS de la firme ESRI) permettra de réaliser une meilleure mise 

en page.  Avant de réaliser votre une mise en page dans ArcGIS, vous devrez exporter votre 

image. 

4.8.5.1 Mise en page cartographique dans ENVI 

Pour ajouter des éléments de mise en page cartographique sur une image (image classifiée 

par exemple) : 

 Ouvrez l’image dans une fenêtre de visualisation 

 Allez dans le menu de cette fenêtre « Overlay / Annotation… » 

 Dans la fenêtre qui s’ouvre, dans le menu « Object », choisissez le type d’objet que 

vous voulez ajouter (texte, légende (« Map Key »), échelle, forme, flèche du Nord, 

etc) 

 Modifiez éventuellement les paramètres de l’objet 

 Cliquez gauche sur l’image à l’endroit où vous voulez insérer l’objet sélectionné 

 Cliquez droit sur l’image pour valider l’insertion de l’objet 

 Répétez ces opérations pour un autre objet 

Pour plus d’information sur l’insertion d’objets sur une image, voyez dans l’aide d’ENVI, dans 

l’index : « Annotation / Adding Annotations ». 

4.8.5.2 Exportation d’une image depuis ENVI 

Une fois votre image classifiée dans ENVI, exportez le résultat. Pour ce faire, 

 Chargez votre image classifiée dans une nouvelle fenêtre de visualisation 

Ensuite, plusieurs possibilités s’offrent à vous. 

 Soit, si vous désirez utiliser votre image classifiée dans un document Word par 

exemple, 

o Cliquez, dans le viewer contenant votre classification, sur  « File > Save Image 

As… > Image File »  

o Ignorez le message d’erreur qui apparait, s’il apparait 

o Choisissez « JPEG » comme « Output File Type »  
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o Indiquez un répertoire de sortie correct 

 Soit, si vous désirez réaliser une belle mise en page cartographique (avec le logiciel 

ArcMap) à partir de votre image classifiée,  

o Cliquez, dans la barre de menu principale d’ENVI, sur « File > Save File As > 

ESRI GRID ». Ce format (ESRI GRID) est nécessaire pour que les classes 

d’occupation du sol, lors de la mise en page de votre carte dans ArcMap, 

apparaissent dans la symbologie et soient disponibles en tant que 

« légende ». (Dans ArcMap, vous devrez renommer vos classes et en modifier 

les couleurs si nécessaire).  

o Sélectionnez l’image à exporter 

o Choisissez un répertoire de sortie (dossier « Résultat ») et donnez un nom 

(moins de 13 caractères et caractères simples) à votre image 

(« VotreNOM_Carte ») 

o Ignorez le message d’erreur et cliquez sur « Ok » 

4.8.5.3 Mise en page cartographique dans ArcGIS 

Pour la mise en page de votre carte, utilisez ArcMap.  

 Insérez votre carte dans un nouveau projet ArcMap et passez en mode « Layout 

view ».  

 Respectez les consignes d’édition cartographique données dans le manuel de TP SIG 

disponible ici http://orbi.ulg.ac.be/handle/2268/135775 à la section « Edition 

cartographique ».  

 Pour créer une légende correcte, vous pouvez renommer vos classes et en changer 

les couleurs via le panneau « table des matières » d’ArcMap.  

 Attention, dans ArcGIS, sauvez votre projet en chemin relatif et exportez votre carte 

en format PDF.  

 

 

http://orbi.ulg.ac.be/handle/2268/135775
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4.9 Création de Néo-canaux 

Il est parfois intéressant de créer de nouveaux canaux (« néo-canaux ») à partir d’images car 

les bandes originales peuvent être fortement corrélées entre elles (redondance de 

l’information) et les néo-canaux peuvent mettre en évidence certains types d’occupation du 

sol ou simplement faciliter la distinction entre classes d’occupation du sol. Ci-dessous des 

exemples de créations de nouveaux canaux qui peuvent par la suite être utilisés en 

classification. 

4.9.1 Analyse en Composante Principale (ACP) 

Définition de l’Analyse en composantes principales (ACP) (Source : Wikipedia, 

http://fr.wikipedia.org/wiki/Analyse_en_composantes_principales) 

L'Analyse en composantes principales (ACP) est une méthode de la famille de l'analyse des 

données et plus généralement de la statistique multivariée, qui consiste à transformer des 

variables liées entre elles (dites "corrélées" en statistique) en nouvelles variables décorrélées 

les unes des autres. Ces nouvelles variables sont nommées "composantes principales", ou 

axes principaux. Elle permet au praticien de réduire le nombre de variables et de rendre 

l'information moins redondante. 

Statistiquement parlant, les premières composantes produites expliquent au mieux la 

variabilité - la variance - des données. Lorsqu'on veut compresser un ensemble de 

variables aléatoires, les  premiers axes de l'analyse en composantes principales sont un 

meilleur choix, du point de vue de l'inertie ou de la variance. 

 Cette méthode est particulièrement indiquée lorsque le nombre de bandes 

spectrales est important (image hyperspectrale), mais pas seulement.  

 Utilisez l’image hyperspectrale CHRIS-PROBA de 62 bandes (répertoire : « … 

\DATA_TP_ENVI_ULg\HYPERSPECTRAL IMAGE CHRIS PROBA ») en demandant la 

production de 62 bandes PCA en sortie. 

 Menu « Transform > Principal Component > Forward PC rotation < Compute new 

statistics and rotate» 

 Visualiser et comparer : 

o  Une composition colorée RGB des 3 premières composantes (bandes 1 à 3 du 

résultat) : image très nette et contrastée, riche en information. 

o Une composition colorée RGB des 3 dernières bandes : très bruyante, pauvre 

en information. 

http://fr.wikipedia.org/wiki/Analyse_en_composantes_principales
http://fr.wikipedia.org/wiki/Analyse_des_donn%C3%A9es
http://fr.wikipedia.org/wiki/Analyse_des_donn%C3%A9es
http://fr.wikipedia.org/wiki/Statistique_multivari%C3%A9e
http://fr.wikipedia.org/wiki/Variance_(statistiques_et_probabilit%C3%A9s)
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o Observations à mettre en relation avec le graphique « PC Eigenvalues » 

automatiquement généré. 

4.9.2 Création d’un indice « NDVI » 

 Menu « Transform > NDVI » et sélectionner les bandes correspondant au rouge et au 

PIR. 

 Cet indice est particulièrement utile pour l’étude de la végétation. 

4.9.3 Création d’un indice « Tasseled Cap » 

La transformation de « Tasseled cap » est utile pour compresser des données spectrales en 

quelques bandes associées à des caractéristiques physiques d’une image (Crist and Cicone 

1984). 

 Dans ENVI, utilisez le menu «  Transform > Tasseled cap » 

 Utilisez l’image Landsat 7 disponible dans le dossier « TASSELED CAP » 

 Ouvrez cette image Landsat 7 dans ENVI via le menu « File > Open External File > 

Landsat > GeoTIFF with Metadata » et choisissez le fichier 

« L71186058_05820030227_MTL.txt », fichier qui contient les métadonnées. 

 Pour les images Landsat 7 ETM, la transformation de « Tasseled cap » produit 6 

bandes: Brightness, Greenness, Wetness, Fourth (Haze), Fifth, Sixth (voir Envi Help). 

 Visualisez et commentez les images obtenues par la transformation de Tasseled Cap. 

 Pour les versions d’ENVI (exemple : ENVI 4.5) ne permettant pas l’ouverture de 

l’image LANDSAT avec le fichier qui contient les métadonnées, il faut ouvrir l’image 

par le menu classique, faire ensuite un « Layer Stacking » (menu « Basic Tools > Layer 

Stacking ») des bandes de résolution spatiale de 30 m et réaliser le calcul de l’indice 

de « Tasseled Cap » à partir de cette image comme indiqué ci-dessus. 

Plus d’informations sur cette transformation sont disponibles dans l’article « DERIVATION OF 

A TASSELED CAP TRANSFORMATION BASED ON LANDSAT 7 AT-SATELLITE REFLECTANCE » 

fourni dans le dossier « TASSELED CAP » ou sur internet. 

4.9.4 Création d’autres indices 

L’outil « Basic tools > Band Math » permet de calculer des indices personnalisés. Pour ce 

faire, il faut d’abord écrire l’équation correspondant à un indice donné avec des variables 

correspondantes aux bandes spectrales, par exemple « b1 + b2 », et ensuite attribuer à 

chaque terme de l’équation une bande spectrale d’une image donnée. 
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4.10 Séparabilité spectrale des classes d’occupation du 
sol sur une image 

Pour cette partie, vous travaillerez sur l’image « SPOT_10m_Namur.tif ». Vous pouvez vous 

aider des ROIs complémentaires fournis dans le dossier « SEPARABILITE ». 

4.10.1 Calcul de la séparabilité spectrale de classes d’occupation du 
sol 

Lors de la création de ROI pour une classification supervisée, il est possible d’étudier la 

séparabilité des classes identifiées par les ROIs. Ce qui donne une idée de la possibilité de 

distinguer ces classes et donc de produire une classification précise. 

Pour faire une analyse de séparabilité spectrale des classes d’occupation du sol : 

 Ouvrez l’image d’intérêt, dans ce cas-ci, l’image « SPOT_10m_Namur.tif ». 

 Appelez la fenêtre de gestion des ROIs via «Click droit sur l’image > ROI Tool » 

 Ouvrez les ROIs correspondant aux classes à étudier, dans ce cas-ci, le fichier 

« ROI_CLASSES_SEPARABILITY.roi» (ROIs correspondants à différentes classes 

d’occupation du sol). 

 Passez en revue ces ROIs à l’aide du bouton « Goto » dans la fenêtre « ROITool » 

 Réalisez une analyse de séparabilité des classes présentes dans ces ROIs via le menu, 

dans  la fenêtre de gestion des ROIs, « Options > Compute ROI separability… > select 

image > select class > select all classes» 

 Analysez le tableau en sortie ! 

o 2 indices de séparabilités sont calculés dans ENVI (confer ENVI Help - Index : 

ROIs / spectral separability) : 

  « Jeffries-Matusita » 

 «  Transformed Divergence » 

La valeur de ces indices varie entre [0 – 2]. Une valeur > 1.9 indique une 

bonne séparation entre 2 classes données. 

 Quelles sont vos conclusions? 

4.10.2 Distribution spectrale dans un graphique 2D (2D Scatter plot) 

L’outil « 2D Scatter Plot » permet de visualiser la distribution des valeurs des pixels dans un 

graphique 2D. Plusieurs options sont disponibles : comparaison de 2 bandes spectrales, 

d’une bande par rapport à des ROIs ou à une classification ( 
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Figure 18). Cet outil est disponible via le menu « Tools > 2 D Scatter Plots… » d’une fenêtre 

de visualisation d’une image. 

 Comparaison de 2 bandes   

o Ouvrir l’image à analyser dans une fenêtre de visualisation 

o Appeler l’outil « Tools > 2 D scatter Plots… » de la fenêtre de visualisation de 

l’image 

o Sélectionner les 2 bandes à comparer (« Band X » and « Band Y ») 

correspondantes aux axes X et Y du graphique 

o Par défaut le nuage de points est blanc.  

o Le graphique est interactif avec les fenêtres de visualisation. Se déplacer dans 

une fenêtre modifiera le nuage de points.  

o Possibilité de représentation par des couleurs dans le nuage de points de 

zones de l’image (classes d’occupation du sol par exemple) particulières. Cela 

donne une idée de leur position dans un nuage de point plus global. 

 En survolant et cliquant sur l’image (« Options > Dance »). Les pixels 

correspondants apparaissaient en rouge dans le nuage de points. 

 En utilisant des ROIs préexistants (« File > Import ROIs… »). La 

localisation des pixels des ROIs dans le nuage de points se fait en 

couleur en fonction des couleurs attribuées aux ROIs (Figure 18, en 

bas). Il peut-être intéressant d’agrandir la fenêtre « image » au 

maximum pour visualiser un maximum de ROIs. 

 En utilisant des ROIs dessinés interactivement sur l’image (« Options > 

Image : ROI »)  

 L’option « Options > Density Slice » et « Options > Select Density 

Lookup… » permettent de colorer le nuage de points en fonction de sa 

densité (Figure 18, centre-haut). 

 Comparaison d’une bande par rapport à une classification (Figure 18, à droite).  

o Ouvrir une image classifiée dans une fenêtre de visualisation 

o Appeler l’outil « Tools > 2 D scatter Plots… » de la fenêtre de visualisation de 

l’image 

o Sélectionner les 2 bandes à comparer (« Band X » and « Band Y ») 

correspondantes aux axes X et Y du graphique avec une des bandes qui 

correspond à une image classifiée. 

o Le graphique produit présente la distribution des valeurs de pixels d’une 

bande dans les différentes classes de l’image et donne une idée de leur 

séparabilités pour une bande donnée. 
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Bande 1 versus Bande 1 

 

Bande 1 versus Bande 4 (Density 

Slice = Rainbow) 

 

Bande 2 versus classes d’une 

image classifiée 

 
Bande 2 versus Bande 4 avec ROIs importés 

 

Figure 18 : différentes utilisations de l’outil « 2D Scatter Plot » 

 

4.10.3 Calcul de statistiques par ROI 

 Pour calculer la superficie (~ nombre de pixels) par classe selon les ROIs (par exemple 

pour vérifier que le nombre de pixels par classe de ROI est suffisant selon les règles 

de l’échantillonnage) 

 « ROI Toool > Options > Report Area of ROI  > m² » 

 Analyse du tableau (superficie par classe dans les ROIs) 
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4.10.4 Courbes de distribution des valeurs de pixels par classe ou 
bande spectrale 

Une fois une image classifiée, il est possible de : 

 Comparer les distributions des valeurs des pixels de toutes les bandes spectrales pour 

une même classe (Figure 19, graphique de gauche). 

 Comparer les distributions des valeurs des pixels d’une bande spectrale pour toutes 

les classes (Figure 19, graphique de droite).  

Ceci est particulièrement intéressant pour identifier les classes multimodales / unimodales !! 

Le menu à utiliser est : « Classification > Post Classification > Class Statistics » 

 Réalisez d’abord une classification supervisée de l’image avec les ROIs du fichier 

« ROI_CLASSES_SEPARABILITY.roi» 

 Utilisez ensuite le menu « Classification > Post Classification > Class Statistics » en 

indiquant comme « Classification Input File », l’image classifiée, puis comme 

« Statistics Input File » l’image originale. Sélectionnez ensuite les classes d’intérêts 

(toutes), et demandez la création de « Basic Stats », « Histograms », « Covariance » 

et « Covariance image ». Et cliquez sur « OK ». 

 2 fonctions sont particulièrement intéressantes : 

o « Select Plot > Histogram: All Bands », et sélectionner une classe dans le menu 

supérieur (Figure 19, à gauche) 

o « Select Plot > Histogram for all classes > Band 1 », par exemple (Figure 19, à 

droite) 

 Le rendu visuel du graphique n’est pas toujours adapté par défaut. Il faut souvent 

modifier l’échelle des ordonnées (axe Y) du graphique. Pour ce faire, faites un clic 

droit près de l’axe, puis « Edit > Plot Parameters > Y Axis » et réduire le range (50 000 

par exemple) pour que les courbes apparaissent correctement. 

 Les statistiques par classe et par bande sont disponibles dans le tableau en-dessous 

des graphiques de la Figure 19, avec corrélation entre les bandes, valeurs de 

distribution des pixels par bande, min, max, mean, etc. 

 Possibilité de sauver le graphique en format jpeg. 
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Figure 19 : courbes de distribution des valeurs de pixels par bande spectrale ou classe d’occupation 

du sol d’une image classifiée et tableau de statistiques 
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4.10.5 Classes spectrales uni-modales et multimodales 

Cette section a pour but de mettre en évidence, à travers des graphiques, le caractère 

multimodal que peuvent prendre les courbes de distribution des valeurs de pixels de classes 

d’occupation du sol mixtes (classes caractérisées par plusieurs comportements spectraux 

différents dus aux différentes occupations du sol contenues dans la classe). 

Pour ce faire : 

 Ouvrir l’image à analyser dans une fenêtre de visualisation, dans ce cas-ci, l’image 

« SPOT_10m_Namur.tif ». 

 Visualisez la bande 4 de l’image en dégradé de gris dans une fenêtre 

 Réalisez 2 classes de ROIs : 

o Classe « BLACK_WHITE_B4 » correspondant à des zones apparaissant comme 

très foncées ou très claires dans la bande B4 (pixels ayant des valeurs 

extrêmement faibles ou élevées dans la bande B4). Cette classe correspondra 

à au moins 2 classes spectrales différentes aura un comportement bi- (ou 

multi) modal.  

o Classe « GRAY_B4 » correspondant à des zones grise dans la bande B4 (pixels 

ayant des valeurs moyennes dans la bande B4). 

o Réalisez une classification supervisée de l’image en utilisant ces 2 classes. 

o Réalisez un graphique comparant la distribution des valeurs des pixels de la 

bande B4 pour ces 2 classes (confer ci-dessus, la section 4.10.4) (Figure 20 : 

Courbes de distribution des valeurs de pixels uni- et tri-modales). 

o Analysez les formes des courbes. 

 Un menu similaire est disponible via : « Basic Tools > Statistics > Compute Satistics > 

Sélectionner l’image classifiée > Cochez « Histograms > Ok > Select Plot > Histogram 

band 1 ». 

  

Figure 20 : Courbes de distribution des valeurs de pixels uni- et tri-modales 
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4.11 Manipulation de données hyperspectrales 

Dans cette section vous aurez brièvement l’occasion de manipuler quelques données de 

type « hyperspectral ». Un signal est dit « hyperspectral » lorsqu’il est composé de 

nombreuses bandes spectrales (généralement 100 ou plus), étroites (1 à 500 nm de largeur 

par exemple) et contiguës (signal continu dans la gamme spectrale considérée) (Figure 22). 

Les données hyperspectrales peuvent se présenter de différentes façons en fonction du 

capteur duquel elles sont issues ( Figure 21) : 

 Image hyperspectrale : il s’agit d’une image (comme une image satellite 

multispectrale par exemple) avec une résolution spectrale très importante. Exemple : 

le capteur “AHS-160” est disposé dans un avion et est composé de 80 bandes 

spectrales, couvrant 5 parties du spectre solaire entre 0.43 – 12.7 µm 

(VIS+NIR+SWIR+TIR). 

 Donnée hyperspectrale ponctuelle : ces données sont enregistrées à l’aide d’un 

capteur portable utilisé par un opérateur directement sur le terrain (en plein air ou 

en laboratoire). Exemple : capteur de type « Analytical Spectral Device (ASD) », qui se 

porte comme un sac à dos et enregistre l’information spectrale dans 2151 bandes 

spectrales contigües de 1 nm de large chacune, entre 350 et 2500 nm. 

 

Figure 21 : Différents types d’acquisitions de données hyperspectrales 



 56 

4.11.1 Manipulation de données hyperspectrales ponctuelles (ASD) 

Les données que vous allez utiliser ont été acquises sur des échantillons de sol agricoles 

étudiés en laboratoire pour différents niveaux d’ombrages et de teneur en eau. 

Le logiciel à utiliser est « ViewSpecPro ». Ce logiciel gratuit peut être téléchargé à l’adresse 

web suivante : http://support.asdi.com/Products/Products.aspx (« ViewSpec Pro Software 

Install »). Un mot de passe est nécessaire pour l’installation du logiciel. Ce mot de passe est à 

demander par email à nir.support@panalytical.com.  

Les fichiers se trouvent dans le répertoire « DATA_TP_ENVI_ULg\HYPERSPECTRAL ASD 

LABO »: 

 Naviguez vers ce répertoire (via Windows) et ouvrez le fichier texte 

« Exemple_fichier_hyperspectral_texte.txt ». Il vous donne un aperçu de comment 

peut être organisé l’information spectrale dans un fichier : une colonne pour les 

longueurs d’ondes (nm) et une pour les valeurs de réflectance. Expliquez les valeurs 

de ces deux colonnes. 

 Démarrez le logiciel « ViewSpecPro » 

 Cliquez sur « File\Open\ » et naviguez jusqu’au répertoire contenant les données 

hyperspectrales 

 Sélectionnez les 4 fichiers dont le nom commence par « Ombre… ». et cliquez sur 

« Ouvrir » 

Les fichiers sélectionnés devraient apparaitre dans la fenêtre principale de « ViewSpecPro » 

 Sélectionnez tous les fichiers et cliquez sur « View\Graph Data ». 

Les spectres correspondants aux fichiers sélectionnés s’affichent à l’écran. 

Selon vous quels sont les spectres correspondants à un ombrage et une teneur en eau 

élevés ? Pourquoi ? 

http://support.asdi.com/Products/Products.aspx
mailto:nir.support@panalytical.com
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Figure 22 : Signatures spectrales pour différents matériaux dans la gamme de longueur d’ondes 
[0.5µm -3µm] 
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4.11.2 Manipulation de données hyperspectrales images (CHRIS-
PROBA) 

4.11.2.1 Présentation de l’image hyperspectrale 

L’image que vous allez utiliser a été acquise par le capteur CHRIS (Compact High Resolution 

Imaging Spectrometer) monté sur le satellite PROBA (Project for On Board Autonomy). Il 

enregistre les images dans 62 bandes spectrales comprises dans l’intervalle [400 nm - 1000 

nm]. Plus d’information sur le couple CHRIS-PROBA est disponible aux pages web suivantes : 

 https://earth.esa.int/web/guest/missions/esa-operational-eo-missions/proba, ESA 

earthnet online (ESA = European Space Agency) 

 https://directory.eoportal.org/web/eoportal/satellite-missions/p/proba-1  

L’image se trouve dans le dossier « …\HYPERSPECTRAL IMAGE CHRIS PROBA » et est 

nommée «CH100728_N.BIN ».  Elle a été enregistrée le 28 juillet 2010 au-dessus d’une 

région agricole au Sud-Ouest de Leipzig (Allemagne) en position « NADIR » (« N ») (capteur à 

la verticale du lieu enregistré). L’extension « .BIN » signifie que l’image est codée en binaire.  

Différents fichiers accompagnent ce fichier image : 

 CH100728_N.HDR, le fichier header créé dans ENVI 

 CH100728_N.hea, un fichier header pour un autre logiciel (autre format) 

 QuicklookCEF4_Leipzig_2010-07-28.jpg, une illustration jpeg basse résolution de 

l’image aussi appelé « Quicklook » pour avoir un aperçu de l’image sans devoir 

utiliser un programme spécialisé. 

 Info Chris wavelengths.xls listant chacune des 62 bandes de l’image avec les 

longueurs d’ondes correspondantes 

 Readme.txt donnant quelques informations supplémentaires sur l’image (nombre de 

lignes et de colonnes, système de coordonnées, format, etc) 

4.11.2.2 Manipulations et analyses à partir de l’image hyperspectrale 

Ouvrez l’image « CH100728_N.BIN ». Constatez que cette image est composée de 62 bandes 

spectrales. Chargez l’image en composition RGB dans une nouvelle fenêtre de visualisation. 

Essayez différentes combinaisons de bandes dont une composition vrai couleur (exemple de 

réponse : R = 21, G = 14, B = 5). Y a-t-il une seule possibilité de composition vrai couleur ?  

Remarquez la présence importante de nuages sur l’image.  

https://earth.esa.int/web/guest/missions/esa-operational-eo-missions/proba
https://directory.eoportal.org/web/eoportal/satellite-missions/p/proba-1
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Jetez un œil aux informations contenues dans le « header file » via un clic droit sur le nom de 

l’image dans la fenêtre « Available Band List » et choisissez « Edit Header …».  Pour constater 

l’importance du « header file » changer un paramètre du header, recharger une composition 

colorée de l’image et constater le changement dans la fenêtre de visualisation. Remodifiez 

les valeurs du « header file » pour afficher correctement l’image dans une nouvelle fenêtre 

de visualisation. 

Utilisez l’outil « Animation » (Tools\Animation) pour visualiser automatiquement les 62 

bandes l’une après l’autre et constater les différences spectrales des bandes pour une 

occupation du sol donnée. 

Utilisez l’outil « 2D Scatter Plot » (Tools\2D Squatter Plot) pour grapher les valeurs de 2 

bandes spectrales en x et y. Faites le pour les combinaisons de bandes suivantes : 

 Bande 1 et bande 2 

 Bande 1 et bande 42 

Quelles différences observez-vous ? entre ces 2 grphiques ? Comment les expliquez-vous ? 

Utilisez l’outil « Z Profile (Spectrum)…» (Tools\Profiles\Z Profile (Spectrum)…) qui permet 

d’extraire le spectre (composé par les 62 bandes de l’image) en 1 pixel donné. Comparez et 

commentez les spectres de différentes occupations du sol et des nuages. 

Construisez un « 3D hyperspectral Cube » via le menu « Spectral\Build 3 D Cube\... » dans le 

menu principal d’ENVI : 

 Choisissez l’image « CH100728_N.HDR » comme « 3D Cube Input File », sans 

« spectral subset » 

 Choisissez ensuite les 3 bandes de l’image qui correspondront à la « façade » du cube 

hyperspectral 

 Réalisez un « spatial subset » pour que les bordures supérieur et de doite de votre 

spatial subset intersectent l’image via le bouton « image » du menu « Select Spatial 

Subset » 

 Choisissez ensuite une « table de couleur » et un répertoire de sortie et nommez 

votre fichier. 

 Chargez ensuite le cube hyperrpsectral dans une nouvelle fenêtre de visualisation et 

analysez le comportement hyperspectral des différentes occupations du sol. 
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4.12 Analyse de séries temporelles d’images basse 
résolution et caractérisation des saisons de 
végétation 

Cette section est consacrée à l’analyse d’une série temporelle d’images satellites basse 

résolution (1 km) de type NDVI en vue d’extraire certains paramètres phénologiques 

caractérisant les saisons de végétation. (Cette section se rapproche en partie de la section 

4.4.3 « Analyse d’une série temporelle d’images NDVI basse résolution (avec WINDISP) » 

page 26) 

4.12.1 Utilité 

Ce type de manipulation peut être utilisé pour caractériser la dynamique annuelle ou 

pluriannuelle de saisons de végétation et/ou de saisons agricoles à l’échelle régionale ou 

nationale par exemple. Des exemples d’applications sont : l’étude de la désertification, la 

prévision des rendements agricoles. Un exemple, en anglais, de l’utilisation de ce logiciel 

dans un système de prévision des rendements agricoles à l’échelle nationale (Arménie) est 

disponible à titre informatif dans la Présentation Power Point disponible via le lien 

http://orbi.ulg.ac.be/handle/2268/145481.  

4.12.2 Présentation du logiciel utilisé : TIMESAT 

Le logiciel utilisé est TIMESAT dont le site web est : 

http://www.nateko.lu.se/TIMESAT/timesat.asp.  

Le principe de base de ce logiciel est simple, comme illustré dans la Figure 23 ci-dessous: 

 Lecture et visualisation d’une série temporelle d’images satellites et production d’une 

courbe traduisant l’évolution temporelle du signal pour chaque pixel (courbe noire) 

 Lissage des courbes traduisant l’évolution temporelle du signal pour chaque pixel 

(courbe rouge).  

 Extraction des informations phénologiques à partir des courbes temporelles lissées et 

production d’images de paramètres phénologiques et d’images de NDVI 

temporellement lissées. 

http://orbi.ulg.ac.be/handle/2268/145481.
http://www.nateko.lu.se/TIMESAT/timesat.asp
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Figure 23 : illustration du fonctionnement de TIMESAT : ligne noire : courbe temporelle bruyante 

du NDVI ; en rouge : courbe temporelle lissée du NDVI ; texte : paramètres phénologiques calculés. 

4.12.3 Téléchargement de TIMESAT 

Ce logiciel est libre et disponible, après enregistrement, via téléchargement sur le site web 

http://www.nateko.lu.se/timesat/timesat.asp?cat=4. Des données exemples et un tutoriel 

(en anglais) sont également disponibles sur ce site web.  

Une fois logué, téléchargez :  

 La version du logiciel adaptée à votre situation. Dans la plupart des cas c’est la 

version “TIMESAT standalone version 3.1.1 for Windows users without Matlab (zip 

archive, 2012-11-22, 181 Mb)” qui doit être téléchargée. Le dossier téléchargé est 

“timesat311_standalone_windows32.zip”. 

4.12.4 Installation de TIMESAT 

Remarque: l’installation pause parfois problème avec certains ordinateurs. 

Pour des informations détaillées sur l’installation, référez-vous aux pages pages 36 and 37 

(section 7) du “TIMESAT 3.1 Software Manual” qui est disponible dans le dossier téléchargé. 

Ci-dessous, un résumé des étapes de l’installation: 

 Déziper (décompresser) le dossier téléchargé 

“timesat311_standalone_windows32.zip” dans un répertoire de votre choix, par 

exemple dans  “...\TP_TELEDETECTION\DATA_TP_ENVI_ULg\TIMESAT\”. Le tutoriel 

“timesat3_1_1_SoftwareManual.pdf” est disponible dans le dossier 

“timesat311_standalone_windows32\timesat311\documentation\”. 

 Si Matlab n’est pas installé sur votre ordianteur, il est nécessaire d’installer 

préalablement le petit programme “Matlab Compiler Runtime (MCR) ». Pour les 

utilisateurs Windows, double-cliquez sur le fichier “MCRinstaller.exe » disponible 

dans le répertoire  

http://www.nateko.lu.se/timesat/timesat.asp?cat=4
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“timesat311_standalone_windows32\timesat311\compiled\Win32\”. Vous recevrez 

peut-être le message suivant ".NET Framework is not installed ». Dans ce cas,  

1. Appuyez sur « cancel » et installez “.NET framework” (disponible via une 

recherche sur Google)   

2. Recommencez le processus d’installation. 

 Sinon cliquez sur “OK to continue". Continuez l’installation en cliquant sur “OK” 

plusieurs fois.  

 Le logiciel TIMESAT lui-même n’a pas besoin d’être installé. 

4.12.5 Démarrage de TIMESAT 

 Pour démarrer TIMESAT double cliquez sur le fichier “TIMESAT.exe” dans le dossier 

“timesat311_standalone_windows32\timesat311\compiled\Win32\”. Si l’ordinateur 

vous demande « Do you want to execute the file”, cliquez sur “yes”. 

 Après le double clic, une fenêtre DOS (ligne de commande) apparait. Attendez 

quelques secondes et ensuite il vous sera demandé d’indiquer la “TIMESAT 

installation folder”. Naviguez jusqu’au dossier “timesat311” comme montré dans la 

Figure 24 et cliquez “OK”. Cette étape est très importante!! 

 

Figure 24: sélection du dossier d’installation de TIMESAT au démarrage de  TIMESAT. 

 

 Ensuite la fenêtre principale de TIMESAT, le “Timesat menu system”, s’ouvrira (Figure 

25). 
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Figure 25: principale interface de TIMESAT 

 

 Dans la fenêtre “Timesat menu system” vous devez indiquer le répertoire de travail 

(« working directory ») (Figure 26) (p. 37 et p. 43 du manuel “TIMESAT 3.1 Software 

Manual”). Cette étape est très importante. Le répertoire de travail est le répertoire 

dans lequel les résultats des calculs de TIMESAT seront enregistrés.  
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 Allez dans “TIMESAT menu system  > File > Preferences” et naviguez jusqu’au 

répertoire de travail, dans ce cas: “…\ 

TIMESAT311\timesat311_standalone_windows32\timesat311\run\.  

 

Figure 26: menu pour définir le répertoire de travail adéquat au démarrage de TIMESAT. 

4.12.6 Utilisation de TIMESAT 

Les objectifs techniques de l’exercice sont de : 

 Visualiser les images NDVI fournies avec le logiciel (application « TSM_imageview ») 

 Visualiser l’évolution temporelle du NDVI pour différents pixels (application 

« TSM_GU I ») (Figure 27) 

 Comparer les différentes méthodes et paramètres de lissage temporel et d’extraction 

des paramètres phénologiques (application « TSM_GUI ») (Figure 27) 

Ceci peut se faire avec les données fournies dans le dossier 

« …\TIMESAT311\timesat311_standalone_windows32\timesat311\data\wa\ » 

 Le fichier liste « ndvilistwa.txt » 

 Les 108 images NDVI allant de « wa_nd00011.img » à « wa_nd99123.img » couvrant 

une période de 3 ans (36 images par an, 1 image par décade). Ces image sont de 

dimensions = 200 lignes * 200 colonnes et  de format de type « 8-bit unsigned ». 

En cas de problème référez-vous au manuel de TIMESAT à partir de la page 40 à la section 

«9 Getting started with TIMESAT – a quick tutorial ». 
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Figure 27 : interface « TSM_GUI » de TIMESAT : visualisation de l’évolution temporelle du signal 
NDVI pour 1 pixel, de son lissage, paramètres et extraction des paramètres phénologiques. 
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5 Visionnage de la vidéo « HOLOGLOBE » 

Cette petite vidéo d’animation de la NASA, d’une durée de 6 minutes, en anglais, montre, 

sur un globe terrestre tournant, la dynamique de plusieurs phénomènes d’origine naturelle 

ou anthropique (Figure 28). 

Cette vidéo est réalisée en grande partie à partir de données issues de satellites 

d’observation de la terre. Entre autres, les phénomènes suivants sont illustrés: 

 Dynamique des flux d’énergie de la terre (mouvements atmosphériques (formation 

des ouragans), courants marins, etc 

 Dynamique des températures des océans et phénomène El Nino 

 Croute et plaques terrestres, tremblements de terre et volcans 

 Saisons et dynamique de la végétation 

 Vision nocturne de l’influence de l’homme sur la terre (lumière artificielle, incendies, 

agriculture sur brulis, combustion de gaz, etc) 

La traduction des commentaires de cette vidéo sont disponibles en Annexe 4, page 82. 

Cette vidéo, et une série d’informations complémentaires, sont disponibles sur le site web 

http://svs.gsfc.nasa.gov/vis/a000000/a000100/a000155/. 

 

 

Figure 28 : illustrations issues de la vidéo « Hologlobe » : mouvements atmosphériques, 
végétation, température des océans. 

 

http://svs.gsfc.nasa.gov/vis/a000000/a000100/a000155/
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6 Recherche d’images satellites sur le web 

Une des premières étapes de tout travail en télédétection spatiale est de se procurer les 

images satellites à partir desquelles votre étude pourra être menée. Cette section à pour 

objectif de vous introduire à la recherche d’images sur le web. 

Avant de commencer votre recherche d’images, il est important que vous cerniez clairement 

quel sont vos objectifs (en termes de résultats) et quels sont vos moyens (connaissance, 

argent, temps).  

Au cours de vos recherches, vous devrez trouver un juste compromis entre ce que le web 

vous « offre » et ce que vous recherchez. En particulier, vous ferez très attention aux critères 

suivants:  

 Type d’image pertinente pour répondre à vos objectifs en termes de résolution 

spatiale, temporelle et spectrale. 

 Disponibilité d’images pour la zone et l’époque sur lesquelles vous voulez travailler 

(couverture nuageuse) 

 Prix des images (gratuit vs très cher !) 

GOOGL EARTH (gratuit) : 

Vous pouvez enregistrer (sur votre disc dur) les images qui apparaissent à l’écran lors de 

votre visite dans Google Earth. Pour ce faire, après avoir zoomé sur le lieu d’intérêt, cliquez 

sur « Fichier/Enregistrez/Enregistrez l’image/… » et vous pourrez sauvegarder la vue en 

format « jpg ». Attention, l’image que vous enregistrez par cette opération n’est donc pas 

une image satellite en tant que telle, mais une simple « capture d’écran » de l’image telle 

qu’elle est affichée sur votre écran. L’information spectrale contenue dans cette image jpg 

est donc  beaucoup plus pauvre que celle contenue dans une image satellite réelle. De plus 

l’image jpg ne sera pas géoréférencée, et la résolution spatiale de l’image dépendra du zoom 

que vous avez utilisé lors de la capture d’écran. Vous devrez donc tenir compte de ces 

limitations si vous comptez utiliser des images dérivées de Google Earth. Un exemple 

d’utilisation d’images de Google Earth : image pour fond de carte à but illustratif. 

IMAGES BASSE RESOLUTION : SPOT VEGETATION, METOP-AVHRR, PROBA-V (gratuit): 

 http://www.vito-eodata.be/PDF/portal/Application.html#Home , S’enregistrer, 

Rechercher un produit, le télécharger et le visualiser dans un viewer 

 VGT extract : logiciel à télécharger (avec java) 

(http://www.vgt4africa.org/VGTExtract.do) et installer sur votre pc. Cet outil permet 

d'extraire du dossier zipper, uniquement les canaux que l'on désire, de découper 

spatialement les images selon une région d'intérêt définit par l'utilisateur ou 

http://www.vito-eodata.be/PDF/portal/Application.html#Home
http://www.vgt4africa.org/VGTExtract.do
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préenregistrée et de convertir les données dans un format plus facile à utiliser (ENVI, 

géotiff, ERMapper ...) Logiciel « Crop VGT » disponible pour les pays non africains. 

 VGT4Africa: http://www.vgt4africa.org/ViewContent.do?pageId=1  

 http://www.spot-vegetation.com/ vidéo global annual change! 

Landsat (gratuit en partie) (dont Landsat 8 depuis avril 2013): 

 http://www.landsat.org/ propose entre autre toute une série d’images d’archive 

gratuitement à une résolution spatiale de 15 à 60 mètres. 

 http://edcsns17.cr.usgs.gov/EarthExplorer/ (USGS EarthExplorer) donne accès à de 

nombreux types d’images dont les images Landsat. 

 http://earthexplorer.usgs.gov/ USGS Earth Explorer 

USGS EarthExplorer 

 http://earthexplorer.usgs.gov/ USGS Earth Explorer, catalogue de la « United States 

Geological Survey » (USGS), donne accès à de nombreux types d’images dont des 

images Landsat, Radar, toutes une série de cartes thématiques (occupation du sol,…), 

etc. 

GLCF : Global Land Cover Facility: http://www.landcover.org/index.shtml  

 Data and product: http://www.landcover.org/data/  

  GIMM : Global Inventory Modeling and Mapping Studies 

http://glcf.umiacs.umd.edu/data/gimms/: animation and download. 

 MODIS http://glcfapp.umiacs.umd.edu:8080/esdi/index.jsp  

Digitalglobe (très haute resolution spatial) 

 Page principale du site web: https://www.digitalglobe.com/  

 Portail de recherche d’images : 

https://browse.digitalglobe.com/imagefinder/main.jsp;jsessionid=7AB20ED95749275

03AD11E38FBEA6237? 

AIRBUS DEFENSE AND SPACE – SPOT IMAGE : 

 http://www.geo-airbusds.com/en/4871-browse-and-order  (produits spot, autres 

satellites, spot scene et spot view, fiches techniques, etc 

http://www.geo-airbusds.com/fr/  

 En 1994, le CNES (Centre National d’Etudes Spatiales français) a lancé le programme 

ISIS (Incitation à l'utilisation Scientifique des Images Spot), destiné à faciliter l'accès 

à l'imagerie Spot pour l'ensemble de la communauté scientifique, en lui permettant 

d'acquérir ces données satellitaires à un tarif préférentiel. ISIS est accessible à tout 

chercheur et étudiant travaillant dans un laboratoire européen. http://www.isis-

cnes.fr/  

Digital GLOBE 

 http://www.digitalglobe.com/ image finder, products (Quickbird) 

 

http://www.vgt4africa.org/ViewContent.do?pageId=1
http://www.spot-vegetation.com/
http://www.landsat.org/
http://edcsns17.cr.usgs.gov/EarthExplorer/
http://earthexplorer.usgs.gov/
http://earthexplorer.usgs.gov/
http://www.landcover.org/index.shtml
http://www.landcover.org/data/
http://glcf.umiacs.umd.edu/data/gimms/
http://glcfapp.umiacs.umd.edu:8080/esdi/index.jsp
https://www.digitalglobe.com/
https://browse.digitalglobe.com/imagefinder/main.jsp;jsessionid=7AB20ED9574927503AD11E38FBEA6237
https://browse.digitalglobe.com/imagefinder/main.jsp;jsessionid=7AB20ED9574927503AD11E38FBEA6237
http://www.geo-airbusds.com/en/4871-browse-and-order
http://www.geo-airbusds.com/fr/
javascript:openGlossary(161,%20'fr');
http://www.isis-cnes.fr/
http://www.isis-cnes.fr/
http://www.digitalglobe.com/
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DEM-MNT (Modèle Numérique de Terrain) (gratuit): 

 Ancien : SRTM 30 mètres (USA) ou 90 mètres (ailleurs) : 

o  http://www2.jpl.nasa.gov/srtm/ et http://srtm.usgs.gov/  

 Nouveau : ASTER GDEM 30 mètres (ASTER Global Digital Elevation Model) (The 

Ministry of Economy, Trade and Industry of Japan (METI) and the National 

Aeronautics and Space Administration (NASA) are collaborating on a project to 

develop ASTER Global Digital Elevation Model (ASTER GDEM), a DEM data which is 

acquired by a satellite-borne sensor "ASTER" to cover all the land on earth) 

o  Download :  

 http://www.gdem.aster.ersdac.or.jp/ (official site: register, log in, 

select regions of interest (small one for faster download), download) 

 https://wist.echo.nasa.gov/wist-

bin/api/ims.cgi?mode=MAINSRCH&JS=1  

o Visualisation : http://www.nasa.gov/topics/earth/features/20090629.html 

PPNC – Plan Photographique Numérique Communal (Belgique) (gratuit) 
La Région Wallonne met à disposition du grand public toute une série d’information de type 

géographique (carte thématique, MNT, etc) sur des serveurs web de type ArcIMS accessible 

en mode « lecture seule » via ArcGIS. 

 Démarrez un projet ArcGIS et référez vous aux notes de TP relatives à ArcGIS 

(disponible ici : http://orbi.ulg.ac.be/handle/2268/135775) à la section « Ajouter des 

données ». 

Autres (gratuit): 

 Africa data dissemination service:   

http://earlywarning.usgs.gov/adds/imgbulks3.php?imgtype=nd&spextent=a 

  Site de BELSPO: liste de satellite et liens: 

http://eo.belspo.be/Directory/Satellites.aspx (cherchez CORONA, IKONOS2, NOAA, 

Airborne platform-Apex, MSG3, PROBA-CHRIS, ENMAP 

 
Remarque : le « Remote Sensing and Geographic Information System Unit » (RS GIS Unit) de 

l’« International Water Management Institute » (IWMI RS/GIS unit) 

(http://www.iwmidsp.org) a publié un document intitulé “Dummies Guide to Search for 

Satellite Images.pdf” (guide pour la recherché d’images satellites). Ce guide, disponible sur 

le site web de l’IWMI, vous donnera un bon aperçu de l’offre en images satellites et vous 

sera probablement utile pour orienter votre recherche. 

http://www2.jpl.nasa.gov/srtm/
http://srtm.usgs.gov/
http://www.ersdac.or.jp/GDEM/E/index.html
http://www.gdem.aster.ersdac.or.jp/
https://wist.echo.nasa.gov/wist-bin/api/ims.cgi?mode=MAINSRCH&JS=1
https://wist.echo.nasa.gov/wist-bin/api/ims.cgi?mode=MAINSRCH&JS=1
http://www.nasa.gov/topics/earth/features/20090629.html
http://orbi.ulg.ac.be/handle/2268/135775
http://earlywarning.usgs.gov/adds/imgbulks3.php?imgtype=nd&spextent=a
http://eo.belspo.be/Directory/Satellites.aspx
http://www.iwmidsp.org/


 70 

7 Sites web intéressants 

Changement de la couverture forestière mondiale entre 2000-2012 à partir d’images 
Landsat, University of Maryland,  application web. 
http://earthenginepartners.appspot.com/science-2013-global-forest 
 
Quelques exemples de détection de changement avec des images Landsat, vidéo, anglais.  
« A Planetary Perspective: With Landsat and Google Earth Engine ». 
http://www.youtube.com/watch?v=Ezn1ne2Fj6Y  
 
Quelques exemples d’applications environnementales à partir des images Landsat, site web, 
anglais. 
« Environmental Watch with Landsat satellites ». 
http://www.nasa.gov/content/goddard/environmental-watch-with-nasa-s-landsat-satellites/  
 
Observation mondiale des feux, de la végétation et de la couverture neigeuse à partir des 
images MODIS NDVI, NASA, entre Juillet 2002 et Juillet 2011. 
http://svs.gsfc.nasa.gov/cgi-bin/details.cgi?aid=3868   
 
Simulation 3D de la couverture nuageuse mondiale durant 7 jours  sur base de données 
réelles, vidéo. 
https://www.youtube.com/watch?annotation_id=annotation_397244329&feature=iv&src_v
id=JZXErLns1mM&v=zlqjz9OEhk0  
 
Simulation numérique des courants atmosphériques et marins, vidéo, anglais.  
« Dynamic Earth, NASA. » 
http://www.youtube.com/watch?v=JQZ3QkaWWqA  
 
Le film documentaire “HOME”, un film de Yann Arthus-Bertrand, 90 minutes, 2009,  français, 
disponible gratuitement ici: 
http://www.youtube.com/watch?v=NNGDj9IeAuI&feature=youtu.be&hd=1.  
Site web du film : http://www.homethemovie.org/. « Ce film développe le lien qui unit 
l'homme à la Terre. Conçu comme un carnet de voyages, il est constitué uniquement 
d'images aériennes et d'une voix off » (Source : Wikipedia). 
 
EARTH as ART, NASA, Top Five, collection de magnifiques images satellites, video, anglais. 
http://www.youtube.com/watch?v=Tq88dRFokgg  
 
EARTH as ART, NASA, collection de magnifiques images satellites  
http://www.nasa.gov/connect/ebooks/earth_art_detail.html 
 

http://earthenginepartners.appspot.com/science-2013-global-forest
http://www.youtube.com/watch?v=Ezn1ne2Fj6Y
http://www.nasa.gov/content/goddard/environmental-watch-with-nasa-s-landsat-satellites/
http://svs.gsfc.nasa.gov/cgi-bin/details.cgi?aid=3868
https://www.youtube.com/watch?annotation_id=annotation_397244329&feature=iv&src_vid=JZXErLns1mM&v=zlqjz9OEhk0
https://www.youtube.com/watch?annotation_id=annotation_397244329&feature=iv&src_vid=JZXErLns1mM&v=zlqjz9OEhk0
http://www.youtube.com/watch?v=JQZ3QkaWWqA
http://www.youtube.com/watch?v=NNGDj9IeAuI&feature=youtu.be&hd=1
http://www.homethemovie.org/
http://fr.wikipedia.org/wiki/Homme
http://fr.wikipedia.org/wiki/Terre
http://www.youtube.com/watch?v=Tq88dRFokgg
http://www.nasa.gov/connect/ebooks/earth_art_detail.html
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8 Quelques logiciels de télédétection spatiale 

Nom Prix Site web 
 

Télédétection   
ENVI Payant http://www.exelisvis.com/ProductsServices/ENVI/ENVI.aspx  
IDRISI Payant http://www.clarklabs.org/products/idrisi.cfm  
ERDAS 
 

Payant http://geospatial.intergraph.com/products/ERDAS-
IMAGINE/Details.aspx  

Quantum GIS 
 

Gratuit http://www.qgis.org/fr/site/  
Via des extensions de Quantum GIS : GDAL/OGR, GRASS, SAGA, etc. 

R Gratuit http://www.r-project.org/ 
Via des packages dédiés aux rasters : raster, rgdal, maptools, etc 
 

SIG   
ArcGIS Payant http://www.arcgis.com/features/  
Quantum GIS 
 

Gratuit http://www.qgis.org/fr/site/  

Pour travailler sur des séries temporelles d’images basse-résolution 
TIMESAT Gratuit http://www.nateko.lu.se/TIMESAT/timesat.asp  
SPIRITS Gratuit https://rs.vito.be/africa/en/software/Pages/Spirits.aspx  
WINDISP Gratuit http://www.fao.org/giews/english/windisp/dl.htm  
VGT EXTRACT 
 

Gratuit http://www.devcocast.eu/VGTExtract.do  

Pour travailler sur des données hyperspectrales ponctuelles 
ViewSpec Pro Gratuit http://support.asdi.com/Products/Products.aspx  
 
 
 

http://www.exelisvis.com/ProductsServices/ENVI/ENVI.aspx
http://www.clarklabs.org/products/idrisi.cfm
http://geospatial.intergraph.com/products/ERDAS-IMAGINE/Details.aspx
http://geospatial.intergraph.com/products/ERDAS-IMAGINE/Details.aspx
http://www.qgis.org/fr/site/
http://www.r-project.org/
http://www.arcgis.com/features/
http://www.qgis.org/fr/site/
http://www.nateko.lu.se/TIMESAT/timesat.asp
https://rs.vito.be/africa/en/software/Pages/Spirits.aspx
http://www.fao.org/giews/english/windisp/dl.htm
http://www.devcocast.eu/VGTExtract.do
http://support.asdi.com/Products/Products.aspx
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Annexe 1 - Les différents types de résolution des images satellites 
 
 

1. Résolution spatiale 
 

 Mesure de la plus petite séparation angulaire ou linéaire entre deux objets, 
habituellement exprimée en radians ou en mètres. 

 Correspond à la longueur des côtés des pixels de l’image 

 
 

2. Résolution temporelle (d’une série temporelle d’images ou d’un capteur) 

 
 Fréquence à laquelle les images d’un endroit donné sont acquises par un capteur 

 

 
Série temporelle de 36 images NDVI décadaires (36 images * 10 jours = 360 jours = 1 an) de type 
SPOT VEGETATION pour le Pakistan et évolution temporelle du NDVI en un pixel présentant une 
alternance marquée de l’état de la végétation selon les saisons. La résolution temporelle de cette 
série est de « 1 image / 10 jours ». 

 

 
 

   
30 mètres (Landsat)      15 mètres (Aster)   10 mètres (SPOT 5)     250 mètres (MODIS) 
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3. Résolution spectrale 
 

 Aptitude d'un système de détection à distinguer des rayonnements 
électromagnétiques de fréquences (ou longueurs d’onde) différentes. 

 La résolution spectrale d’un capteur décrit les fenêtres (gammes) de longueurs 
d’ondes qu’il est capable d’enregistrer. La taille et le nombre de ces fenêtres 
définissent la résolution spectrale d’un capteur. Plus la résolution spectrale est fine, 
plus les fenêtres des différents canaux du capteur sont étroites 

 

 
 
 
 
 
 

 
 

4. Résolution radiométrique 
 

 La résolution radiométrique d'un système de télédétection décrit sa capacité à 
reconnaître de petites différences dans l'énergie électromagnétique. Plus la 
résolution radiométrique d'un capteur est fine, plus le capteur est sensible à de 
petites différences dans l'intensité de l'énergie reçue.  

 La résolution radiométrique est définie par le nombre maximum de niveaux 
d'intensité d'énergie électromagnétique que le capteur peut enregistrer et dépend 
du nombre de bits utilisés pour représenter l'intensité enregistrée, par exemple : 

o Si 8 bit sont utilisés, 28 soit 256 valeurs numériques allant de 0 à 255 sont 
disponibles 

o Si 4 bits sont utilisés, 24 soit 16 valeurs numériques allant de 0 à 15 sont 
disponibles 

    

« Cube hyperspectrale », issu d’un capteur 
hyperspectral (à très haute résolution spectrale). 
Par exemple : 2150 bandes spectrales de 1 nm 
de large chacune. 

Résolution spectrale du capteur SPOT 4, composé de 4 
bandes de largeurs comprises entre 70 et 170µm : 

 B1 : 0,50 à 0,59 mm (90 µm) 

 B2 : 0,61 à 0,68 mm (70 µm) 

 B3 : 0,78 à 0,89 mm (110 µm) 

 MIR : 1,58 à 1,75 mm (170 µm) 
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 En pratique, la résolution radiométrique détermine le niveau de détail discernable 
sur les images. 

 

 
 

 
 
Sources d’inspiration : 

o Centre canadien de télédétection : http://cct.rncan.gc.ca/index_f.php 
o International Training in Yield forecasting, Introduction to remote sensing for 

agriculture applications, Pr. Pierre Defourny (UCL - Geomatics) 
 
 

 
2 bit 

 
8 bit 

  
4 bit      8 bit 

http://cct.rncan.gc.ca/index_f.php
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Annexe 2 - Exemple de matrice de confusion et de son interprétation 
 
 
Considérons une image satellite couvrant une zone d’étude caractérisée par 3 types 
d’occupation du sol à identifier par classification: 

o Eau (rivière, étang) 
o Prairie 
o Forêt 

 
L’image est classifiée et des zones de validation (ou « Ground truth Region Of Interest ») 
sont créées pour chacune des classes d’occupation du sol (Figure 1). Ces zones 
correspondent à des régions pour lesquelles l’occupation du sol est connue avec certitude, 
soit via photo-interprétation, soit via enquête de terrain avec relevés GPS par exemple. La 
précision de la classification de l’ensemble de l’image est ensuite évaluée  en comparant, 
dans ces zones de validation, l’occupation du sol réelle (définie par l’opérateur) avec celle 
identifiée par le processus de classification. 
 

 
Figure 29 : Image classifiée de la zone d’étude. Les encadrés noirs correspondent aux zones de 

validation ou « Ground truth Region Of Interest ». Les classes auxquelles sont assignées chacune 
de ces zones de validation sont mentionnées au-dessus des encadrés. 

 
La matrice de confusion (ou « tableau de contingence ») permet d’évaluer la précision de la 
classification (de manière globale et pour chacune des classes). Elle est calculée à partir des 
pixels correctement/incorrectement classifiés dans les zones de validation mais est sensée 
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être représentative de la précision de la classification de l’ensemble de l’image. D’où 
l’importance de créer suffisamment de zones de validation, correctement réparties sur 
l’ensemble de l’image, et reprenant l’ensemble des réalités spectrales de chacune des 
classes de l’image (exemple : créer des zones de validation de la classe forêt dans les 
différents massifs forestiers de l’image qui présentent probablement de petites nuances 
spectrales (variation de l’exposition, des essences, de l’ensoleillement, etc). 
 
Les zones utilisées pour la validation sont : 

o 2 zones de validation pour la classe « Eau », composées de 17 pixels au total 
o 4 zones de validation pour la classe « Prairie », composées de 33 pixels au total 
o 4 zones de validation pour la classe « Forêt », composées de 30 pixels au total 

 
La matrice de confusion associée à cette classification est reprise en Figure 2. 
 

 Zones de validation 

C
la

ss
if

ic
at

io
n

 

 Eau Prairie Forêt Total 
Erreurs de 

commission 
Précision d’utilisation 

Eau 17 0 1 18 1/18   (6%) 17/18 (94%) 

Prairie 0 27 3 30 3/30  (10%) 27/30 (90%) 

Forêt 0 6 26 32 6/32  (19%) 26/32 (81%) 

Total 17 33 30 80   

Erreurs 
d’omission 

0/17 
(0%) 

6/33 
(18%) 

4/30 
(13%) 

 
Erreur globale : 
10/80 (12,5%) 

 

Précision de 
production 

17/17 
(100%) 

27/33 
(82%) 

26/30 
(87%) 

  
Précision globale :  

70/80 (87,5%) 
Figure 30 : Matrice de confusion associée à la classification de l’image satellite. 

 
La structure (dans cet exemple-ci) de la matrice de confusion est la suivante : 

o Une colonne de la matrice fait référence aux zones de validation de la classe 
identifiée par cette colonne et permet de calculer l’erreur d’omission de cette classe 

o Une ligne de la matrice fait référence aux pixels classifiés dans la classe identifiée par 
cette ligne (dans les zones de validation de l’ensemble des classes) et permet de 
calculer l’erreur de commission de cette classe 

o La diagonale de la matrice de confusion représente tous les pixels correctement 
classifiés : pixels déclarés (par la création des zones de validation) comme 
appartenant à une classe et classifiés par le logiciel dans cette classe 

o La somme des totaux par lignes ou par colonnes correspondent à la somme des pixels 
de l’ensemble des zones de validation de l’ensemble des classes. 

 
Les erreurs d’omission : 
L’erreur d’omission d’une classe donnée est calculée en divisant le nombre total de pixels 
incorrectement classifiés dans les zones de validation de cette classe (« omis » de la classe 
étudiée) par le nombre total de pixels des zones de validation de cette classe. Dans la 
matrice de confusion, ce calcul s’effectue sur base de la colonne correspondant à la classe 
étudiée. 
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o « Eau » : 0 pixel n’ont été mal classifiés sur les 17 pixels des zones de validation de la 
classe « Eau », soit 0/17 = 0% d’erreur d’omission (0% des pixels des zones de 
validation de la classe « Eau » n’ont été omis de la classe « Eau ») 

o « Prairie » : 6 pixel ont été mal classifiés (dans la classe « Forêt ») sur les 33 pixels des 
zones de validation de la classe « Prairie », soit 6/33 = 18% d’erreur d’omission (18% 
des pixels des zones de validation de la classe « Prairie » ont été omis de la classe 
« Prairie » (et classifié dans la classe « Forêt ») alors qu’ils auraient du être classifiés 
dans la classe « Prairie ») 

o « Forêt » : 4 pixel ont été mal classifiés (dans les classes « Eau » et « Prairie») sur les 
30 pixels des zones de validation de la classe « Forêt », soit 4/30 = 13% d’erreur 
d’omission (13% des pixels des zones de validation de la classe « Forêt » ont été omis 
de la classe « Forêt » (et classifié dans les classes « Eau » et « Prairie») alors qu’ils 
auraient du être classifiés dans la classe « Forêt ») 

 
Les précisions de production : 
La précision de production d’une classe donnée est calculée en divisant le nombre total de 
pixels correctement classifiés dans les zones de validation de cette classe par le nombre 
total de pixels des zones de validation de cette classe. Elle est égale à (1-l’erreur d’omission). 
 
La précision de production mesure la probabilité que le processus de classification ait 
classifié un pixel se trouvant dans une zone de validation d’une certaine classe dans cette 
classe. 

Autrement dit : 
Probabilité qu’un pixel qui appartient réellement (dans le monde réel) à une classe « a » ait 
été classifié dans cette classe « a ».  

Autrement dit : 
« En tant que producteur d’une classification (celui qui réalise la classification), je me 
demande, pour un pixel appartenant réellement à la classe « a » (dans le monde réel), quelle 
est la probabilité qu’il ait été classifié dans la classe « a » ? » 
 
Les erreurs de commission : 
L’erreur de commission  d’une classe donnée est calculée en divisant le nombre total de 
pixels incorrectement classifiés dans cette classe dans les zones de validation des autres 
classes (erreur « commise dans les autres classes ») par le nombre total de pixels classifiés 
dans cette classe sur l’ensemble des zones de validation de l’ensemble des classes. Dans la 
matrice de confusion, ce calcul s’effectue sur base de la ligne correspondant à la classe 
étudiée. 

o « Eau » : 1 pixel a été mal classifié (en tant que « Eau ») alors qu’il appartient (d’après 
les zones de validation) à d’autres classes (ici, la classe « Forêt »), sur un total de 18 
pixels classifiés dans la classe « Eau » dans l’ensemble des zones de validation de 
l’ensemble des classes, soit 1/18 = 6% d’erreur de commission (6% des pixels 
classifiés dans la classe « Eau » appartiennent en réalité à d’autres classes (ici la 
classe « Forêt») 

o « Prairie » : 3 pixels ont été mal classifiés (en tant que « Prairie ») alors qu’ils 
appartiennent (d’après les zones de validation) à d’autres classes (ici, la classe 
« Forêt »), sur un total de 30 pixels classifiés dans la classe « Prairie » dans l’ensemble 
des zones de validation de l’ensemble des classes, soit 3/30 = 10% d’erreur de 
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commission (10% des pixels classifiés dans la classe « Prairie » appartiennent en 
réalité à d’autres classes (ici la classe « Forêt») 

o « Forêt » : 6 pixels ont été mal classifiés (en tant que « Forêt ») alors qu’il 
appartiennent (d’après les zones de validation) à d’autres classes (ici, la classe 
« Prairie »), sur un total de 32 pixels classifiés dans la classe « Forêt » dans l’ensemble 
des zones de validation de l’ensemble des classes, soit 6/32 = 19% d’erreur de 
commission (19% des pixels classifiés dans la classe « Forêt » appartiennent en réalité 
à d’autres classes (ici la classe « Prairie») 

 
Les précisions d’utilisation : 
La précision d’utilisation d’une classe donnée est calculée en divisant le nombre total de 
pixels correctement classifiés dans cette classe dans l’ensemble des zones de validation de 
cette classe par le nombre total de pixels classifiés dans cette classe dans l’ensemble des 
zones de validation de l’ensemble des classes. Elle est égale à (1-l’erreur de commission). 
 
La précision d’utilisation mesure la probabilité qu’un pixel appartienne réellement à une 
certaine classe lorsque le processus de classification a classifié ce pixel dans cette classe. 

Autrement dit : 
Probabilité qu’un pixel qui a été classifié dans une classe « a » appartienne réellement (dans 
le monde réel) à cette classe « a ». 

Autrement dit : 
« En tant qu’utilisateur d’une classification (celui qui lit/utilise la classification), je me 
demande, pour un pixel classifié dans une classe « a », quelle est la probabilité qu‘il 
appartienne réellement (dans le monde réel)  à la classe « a ». » 
 
Erreur globale de la classification : 
L’erreur globale de la classification est calculée en divisant le nombre de pixels mal classifiés 
dans l’ensemble des zones de validations de l’ensemble des classes par le nombre de pixels 
de l’ensemble des zones de validation de l’ensemble des classes. L’erreur globale = (1-la 
précision globale). 

o Erreur globale : 10 pixels mal classifiés dans l’ensemble des zones de validation de 
l’ensemble des classes divisé par les 80 pixels de l’ensemble des zones de validation 
de l’ensemble des classes = 12.5 % d’erreur globale. 

 
Précision globale de la classification : 
La précision globale de la classification est calculée en divisant le nombre de pixels 
correctement classifiés dans l’ensemble des zones de validation de l’ensemble des classes 
par l’ensemble des pixels de l’ensemble des zones de validation de l’ensemble des classes. 

o Précision globale : 70 pixels correctement classifiés dans l’ensemble des zones de 
validations de l’ensemble des classes divisé par les 80 pixels de l’ensemble des zones 
de validation de l’ensemble des classes = 87.5 % de précision globale. La précision 
globale = (1- l’erreur globale) 

 
 
Plus d’infos sur les matrices de confusion : Centre Canadien de télédétection 
http://cct.rncan.gc.ca/glossary/index_f.php?id=3124 

 

http://cct.rncan.gc.ca/glossary/index_f.php?id=3124
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Annexe 3 - Matrice de confusion dans ENVI 
Source : ENVI HELP4.4. 

 
Une matrice de confusion permet de mesurer la précision d’un résultat de classification en 
comparant un résultat de classification avec la « vérité terrain ». Cette vérité terrain peut se 
présenter sous la forme de « région d’intérêt – vérité terrain» ou d’une « image-vérité-
terrain ». 
 
Exemple de matrice de confusion. 
 
Confusion Matrix: {M6} (640x400x1)  
Overall Accuracy = (131003/256000) 51.1730%  
Kappa Coefficient = 0.2648  
 

Ground Truth (Pixels) 

Class Unclassified Grass Forest Swamp Total 

Unclassified 43689 26949 40 18001 88679 

Grass 32835 64516 1741 3329 102421 

Forest 8202 7277 4096 654 20229 

Swamp 15227 10742 0 18702 44671 

Total 99953 109484 5877 40686 256000 

 
Ground Truth (Percent) 

Class Unclassified Grass Forest Swamp Total 

Unclassified 43.71 24.61 0.68 44.24 36.64 

Grass 32.85 58.93 29.62 8.18 40.01 

Forest 8.21 6.65 69.70 1.61 7.90 

Swamp 15.23 9.81 0 45.97 17.45 

Total 100 100 100 100 100 

 
Commission and Omission Error 

Class 
Commission 

Percent 
Omission 
Percent 

Commission 
Pixels 

Omission 
Pixels 

Unclassified 50.73 56.29 44990/88679 56264/99953 

Grass 37.01 41.07 37905/102421 44968/109484 

Forest 79.75 30.30 16133/20229 1781/5877 

Swamp 58.13 54.03 25969/44671 21984/40686 

 
Producer and User Accuracy 

Class 
Prod. Acc. 

Percent 
User Acc. 
Percent 

Prod. Acc. 
Pixels 

User Acc. 
Pixels 

Unclassified 43.71 49.27 43689/99953 43689/88679 

Grass 58.93 62.99 64516/109484 64516/102421 

Forest 69.70 20.25 4096/5877 4096/20229 

Swamp 45.97 41.87 18702/40686 18702/44671 
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Overall Accuracy  
The overall accuracy is calculated by summing the number of pixels classified correctly and 
dividing by the total number of pixels. The ground truth image or ground truth ROIs define 
the true class of the pixels. The pixels classified correctly are found along the diagonal of the 
confusion matrix table which lists the number of pixels that were classified into the correct 
ground truth class. The total number of pixels is the sum of all the pixels in all the ground 
truth classes.  
 
Kappa Coefficient  
The kappa coefficient (k) is another measure of the accuracy of the classification.  

 
Confusion Matrix (Pixels)  
The confusion matrix is calculated by comparing the location and class of each ground truth 
pixel with the corresponding location and class in the classification image. Each column of 
the confusion matrix represents a ground truth class and the values in the column 
correspond to the classification image's labeling of the ground truth pixels. For example, 
look at the ground truth column for the Forest class in the Ground Truth (Pixels) table above. 
The ground truth shows 5,877 pixels in this class. The classification was able to classify 4,096 
of these pixels properly but 40 pixels were Unclassified and 1,741 were classified as Grass.  
 
Confusion Matrix (Percent)  
The Ground Truth (Percent) table shows the class distribution in percent for each ground 
truth class. The values are calculated by dividing the pixel counts in each ground truth 
column by the total number of pixels in a given ground truth class. For example, in the Forest 
class the percent pixels classified correctly is 4,096/5,877=0.697 or 69.7%.  
 
Errors of Commission  
Errors of commission represent pixels that belong to another class that are labelled as 
belonging to the class of interest. The errors of commission are shown in the rows of the 
confusion matrix. In the confusion matrix example, the Grass class has a total of 102,421 
pixels where 64,516 pixels are classified correctly and 37,905 other pixels are classified 
incorrectly as Grass (37,905 is the sum of all the other classes in the Grass row of the 
confusion matrix). The ratio of the number of pixels classified incorrectly by the total 
number of pixels in the ground truth class forms an error of commission. For the Grass class 
the error of commission is 37,905/102,421 which equals 37%.  
 
Errors of Omission  
Errors of omission represent pixels that belong to the ground truth class but the 
classification technique has failed to classify them into the proper class. The errors of 
omission are shown in the columns of the confusion matrix. In the confusion matrix 
example, the Grass class has a total of 109,484 ground truth pixels where 64,516 pixels are 
classified correctly and 44,968 Grass ground truth pixels are classified incorrectly (44,968 is 
the sum of all the other classes in the Grass column of the confusion matrix). The ratio of the 
number of pixels classified incorrectly by the total number of pixels in the ground truth class 
forms an error of omission. For the Grass class the error of omission is 44,968/109,484 which 
equals 41.1%.  
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Producer Accuracy  
The producer accuracy is a measure indicating the probability that the classifier has labelled 
an image pixel into Class A given that the ground truth is Class A. In the confusion matrix 
example, the Grass class has a total of 109,484 ground truth pixels where 64,516 pixels are 
classified correctly. The producer accuracy is the ratio 64,516/109,484 or 58.9%.  
 
User Accuracy  
User accuracy is a measure indicating the probability that a pixel is Class A given that the 
classifier has labelled the pixel into Class A. In the confusion matrix example, the classifier 
has labelled 102,421 pixels as the Grass class and a total of 64,516 pixels are classified 
correctly. The user accuracy is the ratio 64,516/102,421 or 63.0%. 
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Annexe 4 - Traduction des commentaires de la vidéo HOLOGLOBE_v3 
 

Source : http://svs.gsfc.nasa.gov/vis/a000000/a000100/a000155/  
Durée : 6 minutes 19 secondes 

 
La terre dans l’espace : 

 9 planètes en orbite autour du soleil 

 3ème planète est la terre 

 Vénus et Mars sont les planètes les plus proches et les plus similaires par rapport à la 
terre.  

 
Mais Vénus et Mars sont très différentes de la terre.  

 Vénus est la plus similaire à la terre point de vue taille, masse et gravité mais a une 
atmosphère dense en CO2 et n’a pratiquement pas d’eau avec une surface très 
chaude (+/- 800°F) = 400°C. (°C = (°F - 32) / 1,8) 

 Mars : moitié de la taille de la terre et une atmosphère mince. Surface est froide (-
190°F) = -123°C et l’eau est gelée à ces pôles et probablement en dessous de sa 
surface. 

 
Notre terre est unique : 

 70% de la surface terrestre est couverte par de l’eau liquide 

 L’atmosphère est riche en vapeur d’eau 

 Planète géologiquement active 

 Caractéristique principale : présence et diversité de la VIE sur terre ! 
 
Les navettes spatiales et les satellites qui enregistrent des images de la terre changent 
notre vision de la terre. 
 
Nous voyons maintenant les océans, les surfaces terrestres, l’atmosphère, la vie, le tout 
interconnecté dans un système mondial. La terre est baignée dans l’énergie solaire. Les 
océans, surfaces terrestres et atmosphères absorbent et sont réchauffés par l’énergie 
solaire. La chaleur absorbée par les océans et transportée par les courants marins est 
continuellement libérée vers l’atmosphère. La chaleur et l’humidité libérées par les océans 
dirigent la circulation atmosphérique et le climat. L’humidité dans l’atmosphère forme les 
nuages qui couvrent en moyenne 40% de la surface terrestre à tout moment donné. 
 
“The pattern in cloud motion in this time lapse sequence shows how earth's winds, moving 
bands or zones, which define regional winds directions” (difficile à comprendre et traduire). 
 
Le mouvement de l’humidité ou de la vapeur d’eau dans l’atmosphère jouent un rôle 
important dans la détermination du climat. Dans cette animation des mouvements des 
vapeurs d’eau de l’atmosphère, les ouragans de 1995 sont visibles. Les ouragans se forment 
au large des côtes africaines (2m32) et se déplacent à l’ouest à travers l’Océan Atlantique 
vers les Caraïbes et la côte est des USA. 
 
Le climat mondial est également influencé par la manière dont la chaleur est répartie par les 
océans. Sont montés ici les changements de températures de surface des océans sur une 

http://svs.gsfc.nasa.gov/vis/a000000/a000100/a000155/
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période de 9 ans. Les surfaces d’eau les plus chaudes sont indiquées en rouge, les plus 
froides en bleu. Avec ce genre de données, il est possible de détecter l’augmentation 
anormale de température qui arrive lorsque les eaux froides en temps normal de l’est de 
l’Océan Pacifique sont remplacées par des eaux plus chaudes. Ce phénomène est connu sous 
le nom d’El Nino. El Nino pourrait perturber le climat à une échelle mondiale causant de 
vastes inondations et sécheresses. 
 
Drainant les océans […], il y a la surface solide de la terre avec la croute terrestre qui est 
divisée en « Hautes terres » et « Basses terres » 

 Les Hautes terres sont les terres émergées qui forment les continents 

 Les Basses terres forment les bassins océaniques. 
 
La croute terrestre n’est pas une coquille fixe et continue. Elle est brisée en une mosaïque 
de plaques mouvantes. Au fur et à mesure que ces plaques bougent et se frottent les unes 
aux autres, elles libèrent d’énormes quantités d’énergie sous la forme de tremblements de 
terre. Les points jaunes montrent la localisation des tremblements de terre qui ont eu lieu 
entre 1980 et 1995 avec une magnitude supérieure à 4.5 sur l’échelle de Richter. Ces 
tremblements de terre indiquent clairement les limites des plaques de la croute terrestre.  
 
Lorsque les plaques océaniques s’entrechoquent avec les plaques terrestres […] cela forme 
les volcans. Les triangles rouges indiquent les éruptions volcaniques enregistrées qui se sont 
passées entre 1960 et 1995. Comme pour les tremblements de terre, la plupart des volcans 
sont localisés le long des limites des plaques terrestres. 
 
Les océans, l’atmosphère et les continents jouent tous un rôle critique pour le maintient de 
la vie durable sur terre. Les caractéristiques des courants marins, des vents, et de la 
topographie peuvent faire d’une région un désert et d’une autre une région verte […]. Les 
changements de saisons affectent grandement la végétation terrestre. Les couleurs vertes 
et jaunes montrent comment les plantes grandissent et dépérissent au cours des saisons 
d’une année. Les vastes déserts du nord de l’Afrique, de la péninsule arabique et de l’Asie 
centrale sont facilement reconnaissables à cause de l’absence de végétation. 
 
L’influence des hommes sur la terre peut également être vue depuis l’espace. Une vision de 
la terre pendant la nuit permet de voir les lumières des campements, villages et villes qui 
sont éclairés. Les endroits fortement peuplés apparaissent en blanc. Les incendies et 
l’agriculture sur brulis (slash and burn) et la combustion de gaz dans les champs de pétroles 
sont montrés en rouge et jaune. Depuis ce point de vue, l’importance de l’activité humaine 
sur la planète peut être évaluée. L’entièreté du globe est concernée. 
 
Un suivi global de la terre nous aide à comprendre les interactions complexes entre les 
atmosphères, les océans et les terres ainsi que leurs impacts sur la vie. Seule une vue 
mondiale nous permet d’apprécier notre terre en tant que planète. 
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Annexe 5 - Wavelength in electromagnetic spectrum 
 

 

 Typical human eye will respond to wavelengths in air from about 380 to 750 nm 

 
http://en.wikipedia.org/wiki/Electromagnetic_spectrum 

 
 

 
 
 
 
 
 

The colors of the visible light spectrum
[2]

 

color wavelength interval frequency interval 

red ~ 630–700 nm ~ 480–430 THz 

orange ~ 590–630 nm ~ 510–480 THz 

yellow ~ 560–590 nm ~ 540–510 THz 

green ~ 490–560 nm ~ 610–540 THz 

blue ~ 450–490 nm ~ 670–610 THz 

violet ~ 400–450 nm ~ 750–670 THz 

 

http://en.wikipedia.org/wiki/Air
http://en.wikipedia.org/wiki/1_E-7_m
http://en.wikipedia.org/wiki/Electromagnetic_spectrum
http://en.wikipedia.org/wiki/Color#_note-1#_note-1
http://en.wikipedia.org/wiki/Red
http://en.wikipedia.org/wiki/Orange_%28colour%29
http://en.wikipedia.org/wiki/Yellow
http://en.wikipedia.org/wiki/Green
http://en.wikipedia.org/wiki/Blue
http://en.wikipedia.org/wiki/Violet_%28color%29

